
HP ProBook 4415s Notebook PC
HP ProBook 4416s Notebook PC
HP ProBook 4515s Notebook PC
Maintenance and Service Guide



© Copyright 2009 Hewlett-Packard
Development Company, L.P.

AMD Athlon, AMD Sempron, AMD Turion,
and ATI Radeon are trademarks of
Advanced Micro Devices, Inc. Bluetooth is a
trademark owned by its proprietor and used
by Hewlett-Packard Company under license.
Intel is a registered trademark of Intel
Corporation in the United States and other
countries. Microsoft, Windows, and Windows
Vista are U.S. registered trademarks of
Microsoft Corporation. SD Logo is a
trademark of its proprietor.

The information contained herein is subject
to change without notice. The only
warranties for HP products and services are
set forth in the express warranty statements
accompanying such products and services.
Nothing herein should be construed as
constituting an additional warranty. HP shall
not be liable for technical or editorial errors
or omissions contained herein.

First Edition: May 2009

Document Part Number: 536499-001



MSG revision history

Revision Publication date Description

A October 2009 ● Updated commodities in the following location: Product description
on page 1.

● Added screw covers to the screw removal images and procedures in the
following location: Switch cover and keyboard on page 61

● Updated descriptions to hard drive spare parts listings in the following locations:
Computer major components on page 34, Sequential part number listing
on page 46, Mass storage devices on page 44, Hard drive on page 74

● Updated descriptions to Bluetooth module spare parts listings in the following
locations: Computer major components on page 34, Sequential part number
listing on page 46, Bluetooth module on page 96

● Added a newly supported WWAN module to spare parts listings in the following
locations: Computer major components on page 34, Sequential part number
listing on page 46, WWAN module on page 70

● Added newly supported processors to spare parts listings in the following
locations: Computer major components on page 34, Sequential part number
listing on page 46, Processor on page 104

● Added newly supported system boards to spare parts listings in the following
locations: Computer major components on page 34, Sequential part number
listing on page 46, System board on page 106

● Deleted a system board spare part from the following locations: Computer
major components on page 34, Sequential part number listing on page 46,
System board on page 106

● Deleted a processor spare part from the following locations: Computer major
components on page 34, Sequential part number listing on page 46,
Processor on page 104

● Deleted a display assembly spare part from the following locations: Computer
major components on page 34, Sequential part number listing on page 46,
Display assembly on computers with 14.0-in displays on page 91
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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description 14.0-in UMA
4415s

14.0-in
Discrete 4416s

15.6-in UMA
4515s

15.6-in
Discrete 4515s

Product
Name

HP ProBook 4415s Notebook PC √  √

 HP ProBook 4416s Notebook PC  √   

 HP ProBook 4515s Notebook PC   √ √

Processors AMD Turion™ II Ultra Dual-Core
Mobile M600 2.4-GHz processor, 2-
MB L2 cache

√ √ √ √

 AMD Turion II Dual-Core Mobile
M520 2.3-GHz processor, 1-MB L2
cache

√ √ √ √

 AMD Turion II Dual-Core Mobile
M500 2.2-GHz processor, 1-MB L2
cache

√ √ √ √

 AMD Turion Ultra Dual-Core ZM-86
2.4-GHz processor, 2-MB L2 cache

√ √ √ √

 AMD Turion X2 Ultra Dual-Core
ZM-84 2.3-GHz processor, 2-MB L2
cache

√ √ √ √

 AMD Turion X2 Dual-Core RM-70
2.0-GHz processor, 1-MB L2 cache

√ √ √ √

 AMD Turion X2 Dual-Core RM-72
2.1-GHz processor, 1-MB L2 cache

√ √ √ √

 AMD Turion X2 Dual-Core RM-74
2.2-GHz processor, 1-MB L2 cache

√ √ √ √

 AMD Turion X2 Dual-Core RM-76
2.3-GHz processor, 1-MB L2 cache

√ √ √ √

 AMD Athlon™ II Dual-Core M320
2.1-GHz processor, 1-MB L2 cache

√ √ √ √

 AMD Athlon II Dual-Core M300 2.0-
GHz processor, 1-MB L2 cache for
use only in Japan, South Korea,
Taiwan, and Thailand

√ √ √ √

 AMD Athlon QL-62 2.0-GHz
processor, 1-MB L2 cache

√ √ √ √
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Category Description 14.0-in UMA
4415s

14.0-in
Discrete 4416s

15.6-in UMA
4515s

15.6-in
Discrete 4515s

 AMD Athlon QL-64 2.1GHz
processor, 1-MB L2 cache

√ √ √ √

 AMD Athlon QL-66 2.2-GHz
processor, 1-MB L2 cache

√ √ √ √

 AMD Sempron™ M100 2.0-GHz
processor, 512-GB L2 cache

√ √ √ √

 AMD Sempron SI-42 2.1GHz
processor, 512KB L2 cache

√ √ √ √

Chipset Northbridge: RS780MN (UMA;
system boards that support AMD
ZM, RM, QL, or SI processors)

√  √  

 Northbridge: RX781 (discrete;
system boards that support AMD
ZM, RM, QL, or SI processors)

 √  √

 Northbridge: AMD RS880M (UMA;
system boards that support AMD
Mxxx processors)

√  √  

 Northbridge: AMD RX881 (discrete;
system boards that support AMD
Mxxx processors)

 √  √

 Southbridge: AMD SB700 (system
boards that support AMD Mxxx
processors)

√ √ √ √

 Southbridge: AMD SB710 (system
boards that support AMD Mxxx
processors)

√ √ √ √

Graphics ATI Radeon™ HD 3200 (UMA) √  √  

 ATI Mobility Radeon HD 4330
(discrete)

ATI-M92S2LP with hypermemory
support

512-MB DDR2 – 500 MHz (64M×16,
Qty 4)

 √  √

Panels All display assemblies include 2
wireless local area network (WLAN)
antennas

√ √ √ √

 14.0-in HD AntiGlare without
webcam

√ √   

 14.0-in HD AntiGlare with webcam √ √   

 14.0-in HD BrightView with webcam √ √   

 14.0-in HD BrightView without
webcam

√ √   

 14.0-in HD BrightView with webcam
and WWAN

√    
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Category Description 14.0-in UMA
4415s

14.0-in
Discrete 4416s

15.6-in UMA
4515s

15.6-in
Discrete 4515s

 15.6-in HD AntiGlare without
webcam

  √ √

 15.6-in HD AntiGlare with webcam   √ √

 15.6-in HD AntiGlare with webcam
and WWAN

  √ √

 15.6-in HD BrightView without
webcam

  √ √

 15.6-in HD BrightView with webcam   √ √

 15.6-in HD BrightView with webcam
and WWAN

  √ √

Memory 2 customer-accessible/upgradable
memory module slots

√ √

 Supports up to 8 GB of DDR2,
PC2-6400, 800-MHz system RAM

√ √ √ √

 Supports the following
configurations:

● 8192-MB total system memory
(4096 × 2, dual-channel)

● 4096-MB total system memory
(4096 × 1, dual-channel)

● 4096-MB total system memory
(2048 × 2, dual-channel)

● 3072-MB total system memory
(2048 + 1024, dual-channel)

● 2048-MB total system memory
(2048 × 1, dual-channel)

● 2048-MB total system memory
(1024 × 2, dual-channel)

● 1024-MB total system memory
(1024 × 1, dual-channel)

√ √ √ √

Hard drives Supports 9.5-mm, 6.35-cm (2.5-in)
hard drives

√ √ √ √

 Customer-accessible, Serial ATA
(SATA)

√ √ √ √
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Category Description 14.0-in UMA
4415s

14.0-in
Discrete 4416s

15.6-in UMA
4515s

15.6-in
Discrete 4515s

 Supports the following drives:

● 160-GB, 5400-rpm

● 160-GB, 7200-rpm

● 250-GB, 5400-rpm

● 250-GB, 7200-rpm

● 320-GB, 5400-rpm

● 320-GB, 7200-rpm

● 500-GB, 5400-rpm

● 500-GB, 7200-rpm

√ √ √ √

 HP 3D DriveGuard √ √ √ √

Optical
drives

Fixed (removal of 1 screw required) √ √ √ √

 Supports no optical drive option √ √ √ √

 12.7-mm tray load, SATA √ √ √ √

 Supports the following drives:

● DVD±RW and CD-RW Super
Multi Double-Layer Combo
Drive with LightScribe

● DVD-ROM Drive

● Blu-ray ROM DVD+/-RW
SuperMulti DL Drive

√ √ √ √

Diskette
drive

Supports external USB diskette
drive only

√ √ √ √

Webcam Integrated 2 MP webcam √ √ √ √

Audio ADI 1984JCPZ √ √ √ √

 IDT High Definition audio √ √ √ √

 Integrated microphone √ √ √ √

 Stereo speakers √ √ √ √

 Headphone and microphone jacks √ √ √ √

Modem 56K v.92 MDC data/fax modem √ √ √ √

 Supports no modem option √ √ √ √

 Modem cable not included √ √ √ √

Ethernet Marvell 10/100/1000 Ethernet
88E8072-B1 network interface card
(NIC)

√ √ √ √

 Ethernet cable not included √ √ √ √
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Category Description 14.0-in UMA
4415s

14.0-in
Discrete 4416s

15.6-in UMA
4515s

15.6-in
Discrete 4515s

 S3/S4/S5 wake on LAN (AC mode
only)

√ √ √ √

Wireless Integrated WLAN options by way of
MiniPCI card

√ √ √ √

 2 WLAN antennas built into display
assembly

√ √ √ √

 Support for no-WLAN option √ √ √ √

 Support for the following WLAN
formats:

● Broadcom 802.11a/b/g/n

● Broadcom 802.11b/g

√ √ √ √

 Wireless personal area network
(WPAN) by way of Bluetooth®
module:

√ √ √ √

 Support for no-WPAN option √ √ √ √

 Bluetooth 2.0 module √ √ √ √

 Bluetooth 2.1 module √ √ √ √

 Wireless Wide Area Network
(WWAN)

√ √ √ √

 Subscriber Identity Module (SIM)   √ √

 WWAN module UNDP, GPS   √ √

 WWAN module 3G √    

 2 WWAN antennas (world-wide 5
panel, configured with panel)

  √ √

 No support for WWAN after market
option

√ √ √ √

External
Media Cards

One ExpressCard – 34 mm √ √ √ √

 Media Card Reader supporting
Memory Stick (MS),
MultiMediaCard (MMC), Secure
Digital (SD) Memory Card, xD-
Picture Card (XD)

√ √ √ √

Ports Audio-in (stereo microphone) √ √ √ √

 Audio-out (stereo headphone) √ √ √ √

 RJ-11 (modem) √ √ √ √

 RJ-45 (Ethernet, includes link and
activity lights)

√ √ √ √

 USB 2.0 (4) √ √ √ √
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Category Description 14.0-in UMA
4415s

14.0-in
Discrete 4416s

15.6-in UMA
4515s

15.6-in
Discrete 4515s

 VGA (Dsub 15-pin) supporting 1600
× 1200 external resolution at 75-
GHz (hot plug/unplug with auto-
detect)

√ √ √ √

 High-Definition Multimedia Interface
(HDMI)

√ √ √ √

 Multi-pin AC power √ √ √ √

Keyboard/
pointing
devices

14.0-in keyboard with TouchPad √ √   

 15.6-in/17.3-in keyboard with
TouchPad

  √ √

 TouchPad supports 2-way scroll
(taps enabled as default)

√ √ √ √

Power
requirements

90-W Smart AC adapter (discrete
models)

 √  √

 65-W Smart AC adapter (UMA
models)

√  √  

 6-cell, 47-Wh Li-ion battery (L-cavity
for 14.0-in models)

√ √   

 8-cell, 63-Wh Li-ion battery (in-line
cavity for 15.6-in models)

  √ √

 6-cell, 47-Wh Li-ion battery (in-line
cavity for 15.6-in models)

  √ √

Security Supports Kensington security lock √ √ √ √

 No TPM support √ √ √ √

Operating
system

Preinstalled:     

 ● Windows® 7 Pro 32 with
Microsoft® Basics

√ √ √ √

 ● Windows 7 Home Premium 32
with Microsoft Basics

√ √ √ √

 ● Windows Vista® Home Basic
32 with MS Basics (Japan only)

√ √ √ √

 ● Windows Vista Business 32
with MS Basics (Japan only)

√ √ √ √

 ● Windows Vista Business 32
(with Windows® XP Pro
images) with MS Basics

√ √ √ √

 ● Windows Vista Home Basic 32
with Office 2007 Personal
(Japan only)

√ √ √ √

 ● Windows XP Professional with
Microsoft Basics (with
Windows 7 Professional COA)

√ √ √ √
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Category Description 14.0-in UMA
4415s

14.0-in
Discrete 4416s

15.6-in UMA
4515s

15.6-in
Discrete 4515s

 ● Red Flag Linux (in the People's
Republic of China only)

√ √ √ √

 ● SuSE Linux √ √ √ √

 ● FreeDOS √ √ √ √

 Preinstalled with Office:     

 ● Windows 7 Home Basic 32
with Office 2007 Ready (for
use in all countries or regions
except Japan)

√ √ √ √

 ● Windows 7 Home Premium 32
with Office 2007 Ready (for
use in all countries or regions
except Japan)

√ √ √ √

 ● Windows 7 Home Premium 32
with Office 2007 Personal (for
use only in Japan)

√ √ √ √

 ● Windows 7 Home Premium 32
with Office 2007 Personal with
Powerpoint (for use in all
countries or regions except
Japan)

√ √ √ √

 ● Windows 7 Home Premium 32
with Office 2007 Professional
(for use only in Japan)

√ √ √ √

 ● Windows 7 Pro 32 with Office
2007 Ready (for use in all
countries or regions except
Japan)

√ √ √ √

 ● Windows 7 Pro 32 with Office
2007 Personal (for use only in
Japan)

√ √ √ √

 ● Windows 7 Pro 32 with Office
2007 Personal with
Powerpoint (for use only in
Japan)

√ √ √ √

 ● Windows 7 Pro 32 with Office
2007 Professional (for use only
in Japan)

√ √ √ √

 ● Windows Vista Basic 32 with
Office 2007 Professional
(Japan only)

√ √ √ √

 ● Windows Vista Basic 32 with
Office 2007 Personal (Japan
only)

√ √ √ √

 ● Windows Vista Basic 32 with
Office 2007 Personal with PP
(Japan only)

√ √ √ √
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Category Description 14.0-in UMA
4415s

14.0-in
Discrete 4416s

15.6-in UMA
4515s

15.6-in
Discrete 4515s

 ● Windows Vista Basic 32 with
Office 2007 Ready (except
Japan)

√ √ √ √

 ● Windows Vista Basic 32 with
Office 2007 Ready – China
Mobile

√ √ √ √

 ● Windows Vista Home
Premium 32 with Office 2007
Ready (except Japan)

√ √ √ √

 ● Windows Vista Business 32
with Office 2007 Ready
(except Japan)

√ √ √ √

 ● Windows Vista Business 32
with Office 2007 Personal with
PP (Japan only)

√ √ √ √

 ● Windows Vista Business 32
(with XP Pro images) with
Ofice 2007 Ready (except
Japan)

√ √ √ √

 ● Windows Vista Business 32
(with XP Pro images) with
Office 2007 Personal (Japan
only)

√ √ √ √

 ● Windows Vista Business 32
(with XP Pro images) with
Office 2007 Personal with PP
(Japan only)

√ √ √ √

 ● Windows Vista Business 32
(with XP Pro images) with
Office 2007 (Japan only)

√ √ √ √

 ● Windows Vista Business 32
with Office 2007 Professional
(Japan only)

√ √ √ √

 ● Windows Vista Business 32
with Office 2007 Personal
(Japan only)

√ √ √ √

 Restore media:     

 ● Windows 7 √ √ √ √

 ● Windows 7 Home Basic 32 √ √ √ √

 ● Windows 7 Home Premium 32 √ √ √ √

 ● Windows 7 Professional 32 √ √ √ √

 ● Windows Vista 32 Home Basic √ √ √ √

 ● Windows Vista Business 32 √ √ √ √

 ● Windows Vista Business 64 √ √ √ √
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Category Description 14.0-in UMA
4415s

14.0-in
Discrete 4416s

15.6-in UMA
4515s

15.6-in
Discrete 4515s

 ● Windows Vista (Office Ready
DVD)

√ √ √ √

 ● Windows Vista Home
Premium

√ √ √ √

 ● Windows Vista (DRDVD) √ √ √ √

 ● Windows XP Professional √ √ √ √

 ● Windows XP Pro (DRDVD) √ √ √ √

 ● Red Flag Linux (in the People's
Republic of China only)

√ √ √ √

 ● SuSE Linux √ √ √ √

 Certified: Microsoft® WHQL √ √ √ √

 Web-only Support: √ √ √ √

 ● Windows Vista Business 64 √ √ √ √

 ● Windows 7 Professional 64 √ √ √ √

Serviceability End-user replaceable parts:     

 AC adapter √ √ √ √

 Battery (system) √ √ √ √

 Hard drive √ √ √ √

 Memory module √ √ √ √

 Optical drive √ √ √ √

 WLAN module √ √ √ √

 WWAN module √ √ √ √

 SIM √ √ √ √
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2 External component identification

Windows Vista and Windows XP
Display

NOTE: Your computer may look slightly different from the illustration in this section.

Component Description

(1) Internal display switch Turns off the display if the display is closed while the power is on.

(2) Internal microphone Records sound.

(3) Webcam light (select models only) On: The webcam is in use.

(4) Webcam (select models only) Records audio and video and captures still photographs.
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Top components

Pointing devices

Component Description

(1) TouchPad* Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) TouchPad scroll zone Scrolls up or down.

(4) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings.

To view or change pointing device preferences in Windows Vista, select Start > Control Panel > Hardware and Sound >
Mouse.

To view or change pointing device preferences in Windows XP, select Start > Control Panel > Printers and Other
Hardware > Mouse.
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Lights
NOTE: Your computer may look slightly different from the illustration in this section.

Component Description

(1) Caps lock light On: Caps lock is on.

(2) Info Center/QuickLook light ● On: The computer is on.

● Blinking (5 times):

◦ When the computer is on, press button to launch Info
Center.

◦ When the computer is off or in Hibernation, press button
to launch QuickLook.

● Off: The computer is in Hibernation, or in the Sleep state
(Windows Vista) or Standby (Windows XP).

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows Vista)
or Standby (Windows XP).

● Off: The computer is off or in Hibernation.
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Buttons, switches, and speakers
NOTE: Your computer may look slightly different from the illustration in this section.

Component Description

(1) Speakers (2) Produce sound.

(2) Internal display switch Turns off the display if the display is closed while the power is on.

(3) Info Center/Quick Look button Launches Info Center or QuickLook.

(4) Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button to shut down the
computer.

● When the computer is in the Sleep state (Windows Vista) or
Standby (Windows XP), press the button briefly to exit Sleep
or Standby.

● When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and Windows shutdown
procedures are ineffective, press and hold the power button for at
least 5 seconds to turn off the computer.

To learn more about your power settings and how to change them,
select Start > Control Panel > System and Maintenance >
Power Options.
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Keys
NOTE: Refer to the illustration that most closely matches your computer.

Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key, the num lk key, or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys When the keypad has been enabled, the keys can be used like the
keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Integrated numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Front components

Component Description

(1) Drive light ● Blinking turquoise: The hard drive or optical drive is being
accessed.

● Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

(2) Wireless switch Turns the wireless feature on or off but does not establish a
wireless connection.

NOTE: You must set up or access a wireless network to establish
a wireless connection.

(3) Wireless light ● Blue: An integrated wireless device, such as a wireless local
area network (WLAN) device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(4) Media Card Reader Supports the following optional digital card formats:

● Memory Stick (MS)

● Memory Stick Pro (MSP)

● MultiMediaCard (MMC)

● MultiMediaCard 4.2 (MMC Plus, including MMC Plus HC)

● Secure Digital (SD) Memory Card

● Secure Digital High Capacity (SDHC) Memory Card

● Secure Digital High Speed (SDHS) Memory Card

● xD-Picture Card (XD)

● xD-Picture Card (XD) Type H

● xD-Picture Card (XD) Type M

(5) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(6) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.
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Right-side components

Component Description

(1) USB ports (2) Connect optional USB devices.

(2) RJ-11 (modem) jack (select models only) Connects a modem cable.

(3) Optical drive (select models only) Reads optical discs and, on select models, also writes to optical
discs.

(4) Optical drive light (select models only) Blinking: The optical drive is being accessed.

(5) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins blinking
rapidly.

● Off: If the computer is plugged into an external power source,
the light turns off when all batteries in the computer are fully
charged. If the computer is not plugged into an external power
source, the light stays off until the battery reaches a low
battery level.

(6) Power connector Connects an AC adapter.
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Left-side components

Component Description

(1) ExpressCard slot Supports optional ExpressCards.

(2) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

(3) RJ-45 (network) jack Connects a network cable.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5) External monitor port Connects an external VGA monitor or projector.

(6) HDMI port Connect an optional HDMI device.

(7) USB ports (2) Connect optional USB devices.
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Bottom components

Component Description

(1) Battery release latches (2) Release the battery from the battery bay.

(2) Battery bay Holds the battery.

Wireless antennas

Component Description

(1) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

Windows Vista and Windows XP 19



Component Description

(2) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

*To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental Notices that applies to
your country or region. These notices are located in Help and Support.

NOTE: The antennas are not visible from the outside of the computer. For optimal transmission, keep
the areas immediately around the antennas free from obstructions.

Additional hardware components

Component Description

(1) Power cord* Connects an AC adapter to an AC outlet.

(2) Battery* Powers the computer when the computer is not plugged into
external power.

(3) AC adapter Converts AC power to DC power.

*Batteries and power cords vary in appearance by country or region.
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Linux
Display

NOTE: Your computer may look slightly different from the illustration in this section.

Component Description

(1) Internal display switch Turns off the display if the display is closed while the power is on.

(2) Internal microphone Records sound.

(3) Webcam light (select models only) On: The webcam is in use.

(4) Webcam (select models only) Records audio and video and captures still photographs.
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Top components

Pointing devices

Component Description

(1) TouchPad Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button Functions like the left button on an external mouse.

(3) TouchPad scroll zone Scrolls up or down.

(4) Right TouchPad button Functions like the right button on an external mouse.
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Lights
NOTE: Your computer may look slightly different from the illustration in this section.

Component Description

(1) Caps lock light On: Caps lock is on.

(2) Info Center/QuickLook light ● On: The computer is on.

● Blinking (5 times):

◦ When the computer is on, press button to launch Info
Center.

◦ When the computer is off or in Hibernation, press button
to launch QuickLook.

● Off: The computer is off or in the Suspend or Hibernation state.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in Suspend.

● Off: The computer is off or in Hibernation.
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Buttons, switch, and speakers
NOTE: Your computer may look slightly different from the illustration in this section.

Component Description

(1) Speakers (2) Produce sound.

(2) Internal display switch Turns off the display if the display is closed while the power is on.

(3) Info Center/QuickLook button Launches Info Center or QuickLook.

(4) Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button to shut down the
computer.

● When the computer is in Suspend, press the button briefly to
exit Suspend.

● When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and operating system
shutdown procedures are ineffective, press and hold the power
button for at least 5 seconds to turn off the computer.

To learn more about your power settings and how to change them,
select Computer > Control Center > System > Power
Management.
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Keys
NOTE: Refer to the illustration that most closely matches your computer.

Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key, the num lk key, or the esc key.

(3) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(4) Embedded numeric keypad keys When the keypad has been enabled, the keys can be used like the
keys on an external numeric keypad when pressed in combination
with the fn and num lk keys.
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Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(4) Integrated numeric keypad keys Can be used like the keys on an external numeric keypad.
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Front components

Component Description

(1) Drive light Blinking turquoise: The hard drive or optical drive is being
accessed.

(2) Wireless switch Turns the wireless feature on or off but does not establish a
wireless connection.

NOTE: You must set up or access a wireless network to establish
a wireless connection.

(3) Wireless light ● Blue: An integrated wireless device, such as a wireless local
area network (WLAN) device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(4) Media Card Reader Supports the following optional digital card formats:

● Memory Stick (MS)

● Memory Stick Pro (MSP)

● MultiMediaCard (MMC)

● MultiMediaCard 4.2 (MMC Plus, including MMC Plus HC)

● Secure Digital (SD) Memory Card

● Secure Digital High Capacity (SDHC) Memory Card

● Secure Digital High Speed (SDHS) Memory Card

● xD-Picture Card (XD)

● xD-Picture Card (XD) Type H

● xD-Picture Card (XD) Type M

(5) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(6) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.
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Right-side components

Component Description

(1) USB ports (2) Connect optional USB devices.

(2) RJ-11 (modem) jack (select models only) Connects a modem cable.

(3) Optical drive (select models only) Reads optical discs and, on select models, also writes to optical
discs.

(4) Optical drive light (select models only) Blinking: The optical drive is being accessed.

(5) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins blinking
rapidly.

● Off: If the computer is plugged into an external power source,
the light turns off when all batteries in the computer are fully
charged. If the computer is not plugged into an external power
source, the light stays off until the battery reaches a low
battery level.

(6) Power connector Connects an AC adapter.
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Left-side components

Component Description

(1) ExpressCard slot Supports optional ExpressCards.

(2) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

(3) RJ-45 (network) jack Connects a network cable.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5) External monitor port Connects an external VGA monitor or projector.

(6) HDMI port Connects an optional HDMI device

(7) USB ports (2) Connect optional USB devices.
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Bottom components

Component Description

(1) Battery release latches (2) Release the battery from the battery bay.

(2) Battery bay Holds the battery.
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Wireless antennas

Component Description

(1) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(2) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

*To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental Notices that applies to
your country or region. These notices are located on the User Guide disc that has be provided with your computer.

NOTE: The antennas are not visible from the outside of the computer. For optimal transmission, keep
the areas immediately around the antennas free from obstructions.
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Additional hardware components

Component Description

(1) Power cord* Connects an AC adapter to an AC outlet.

(2) Battery* Powers the computer when the computer is not plugged into
external power.

(3) AC adapter Converts AC power to DC power.

*Batteries and power cords vary in appearance by country or region.
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3 Illustrated parts catalog

Service tag
The service tag, affixed to the bottom of the computer, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for
the computer.

(5) Warranty period: Describes the duration of the warranty period for this computer.

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Computer major components

Item Description Spare part number

(1) Display assembly (includes 2 WLAN antenna transceivers and cables)

 For use only with black computers with 15.6-in HD LED displays  

 ● AntiGlare display assembly for use in computers not equipped with a webcam 536790-001

 ● BrightView display assembly for use in computers equipped with a webcam 536791-001

 ● BrightView display assembly for use in computers not equipped with a webcam 536792-001

 ● BrightView display assembly for use in computers equipped with a webcam 536793-001
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Item Description Spare part number

 ● AntiGlare display assembly for use on computers equipped with a webcam and WWAN
module

536794-001

 ● BrightView display assembly for use on computers equipped with a webcam and WWAN
module

536795-001

 For use only with red computers with 15.6-in HD displays  

 ● AntiGlare display assembly for use in computers not equipped with a webcam 572936-001

 ● AntiGlare display assembly for use in computers equipped with a webcam 572937-001

 ● BrightView display assembly for use in computers not equipped with a webcam 572938-001

 ● BrightView display assembly for use in computers equipped with a webcam 572939-001

 ● AntiGlare display assembly for use in computers equipped with a webcam and WWAN
module

572940-001

 ● BrightView display assembly for use on computers equipped with a webcam and WWAN
module

572941-001

 For use only with black computers with 14.0-in HD displays  

 ● AntiGlare display assembly for use in computers not equipped with a webcam 536784-001

 ● AntiGlare display assembly for use in computers equipped with a webcam 536785-001

 ● BrightView display assembly for use in computers not equipped with a webcam 536786-001

 ● BrightView display assembly for use in computers equipped with a webcam 536787-001

 ● BrightView display assembly for use in computers equipped with a webcam and WWAN
module

578366-001

 For use only with red computers with 14.0-in HD displays  

 ● AntiGlare display assembly for use in computers not equipped with a webcam 572932-001

 ● AntiGlare display assembly for use in computers equipped with a webcam 572933-001

 ● BrightView display assembly for use in computers not equipped with a webcam 572934-001

 ● BrightView display assembly for use in computers equipped with a webcam 572935-001

(2) Switch cover  

 For use in black computers with 15.6-in displays 535861-001

 For use in red computers with 15.6-in displays 572726-001

 For use in black computers with 14.0-in displays 535860-001

 For use in red computers with 14.0-in displays 572725-001

(3) Keyboard

NOTE: For a detailed list of available keyboards, see Sequential part number listing on page 46.

 For use in computers with 15.6-in displays 536537-xxx

 For use in computers with 14.0-in displays 536410-xxx

(4) Palm rest (includes TouchPad)  

 For use in black computers with 15.6-in displays 535868-001
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Item Description Spare part number

 For use in red computers with 15.6-in displays 572728-001

 For use in black computers with 14.0-in displays 535867-001

 For use in red computers with 14.0-in displays 572727-001

(5) Speakers  

 For use in computers with 15.6-in displays 536598-001

 For use in computers with 14.0-in displays 536420-001

(6) Top cover  

 For use in computers with 15.6-in displays 535866-001

 For use in computers with 14.0-in displays 535865-001

(7) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part numbers 536539-001 (for
computers with 15.6-in displays) and 536538-001 (for computers with 14.0-in displays). See
Cable Kit on page 43 for more Cable Kit spare part information.

 

 For use in all countries and regions except Australia and New Zealand 510100-001

 For use only in Australia and New Zealand 510100-011

(8) Fan 535766-001

 Heat sink  

(9a) For use in computers with discrete graphics subsystems 535805-001

(9b) For use in computers with UMA graphics subsystems 535804-001

(10) System board (includes replacement thermal material)

 For use in computers without a WWAN module that use AMD Mxxx processors:  

 ● UMA graphics subsystem memory 585219-001

 ● Discrete graphics subsystem memory 585221-001

 For use in computers with a WWAN module that use AMD Mxxx processors:  

 ● UMA graphics subsystem memory 585218-001

 ● Discrete graphics subsystem memory 585220-001

 For use in computers without a WWAN module that use AMD ZM, RM, QL, or SI
processors:

 

 ● UMA graphics subsystem memory 574505-001

 ● Discrete graphics subsystem memory 574506-001

 For use in computers with a WWAN module that use AMD ZM, RM, QL, or SI processors:  

 ● Discrete graphics subsystem memory 535803-001

(11) Bluetooth module  

 For use only in models with the following system boards: 535803-001, 574505-001,
574506-001

398393-002
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Item Description Spare part number

 For use only in models with the following system boards: 585218-001, 585219-001,
585220-001, 585221-001

537921-001

(12) Processor (includes replacement thermal material) (not illustrated)

 AMD Turion II Ultra Dual-Core processors (for use only with the following system boards: 585218-001, 585219-001,
585220-001, 585221-001)

 ● M500 (2.2-GHz with 1-MB L2 cache) 576253-001

 ● M520 (2.3-GHz with 1-MB L2 cache) 583055-001

 ● M600 (2.4-GHz with 2-MB L2 cache) 576254-001

 AMD Turion Ultra Dual-Core processors (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

 

 ● ZM-84 (2.3-GHz with 2-GB L2 cache) 507975-001

 ● ZM-86 (2.4-GHz with 2-GB L2 cache) 507974-001

 AMD Turion Dual-Core processors (for use only with the following system boards: 574505-001, 574506-001,
585802-001, 585803-001)

 ● RM-70 (2.0-GHz with 1-GB L2 cache) 507977-001

 ● RM-72 (2.1-GHz with 1-GB L2 cache) 507978-001

 ● RM-74 (2.2-GHz with 1-GB L2 cache) 507979-001

 ● RM-76 (2.3-GHz with 1-GB L2 cache) 572748-001

 AMD Athlon II Dual-Core processors (for use only with the following system boards: 585218-001, 585219-001,
585220-001, 585221-001)

 ● M300 (2.0-GHz with 1-MB L2 cache) 578024-001

 ● M320 (2.1-GHz with 1-MB L2 cache) 576252-001

 AMD Athlon Dual-Core processors (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

 

 ● QL-62 (2.0-GHz with 1-GB L2 cache) 506052-001

 ● QL-66 (2.2-GHz with 1-GB L2 cache) 572747-001

 AMD Sempron processors  

 ● M100 (2.0-GHz with 512-GB L2 cache; for use only with the following system boards:
585218-001, 585219-001, 585220-001, 585221-001)

576251-001

 ● SI-42 (2.1-GHz with 512-KB L2 cache; for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

508102-001

(13) Optical drive connector 535862-001

(14) WLAN module  

 Broadcom 4322 802.11a/b/g/n WLAN modules

 ● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504664-001
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Item Description Spare part number

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

504664-002

 Broadcom BCM4312 802.11b/g WLAN modules:

 ● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504593-003

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

504593-004

(15) RTC battery 449137-001

(16) Memory modules (PC2-6400, 800-MHz, DDR2)  
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Item Description Spare part number

 1-GB 535809-001

 2-GB 535810-001

(17) WWAN module  

 For use in all countries and regions except China 483377-002

 For use in China 571888-001

 Including GPS, UNDP (United Nations Development Program; not available with Linux) 531993-001

(18) Subscriber identification module (SIM) 536599-001

(19) Base enclosure  

 For use in computers with 15.6-in displays 535864-001

 For use in computers with 14.0-in displays 535863-001

(20) Hard drive (includes hard drive bracket)

 500-GB, 7200-rpm 575125-001

 500-GB, 5400-rpm 535814-001

 320-GB, 7200-rpm 575124-001

 320-GB, 5400-rpm (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535813-001

 250-GB, 7200-rpm 536783-001

 250-GB, 5400-rpm (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535812-001

 160-GB, 7200-rpm 536782-001

 160-GB, 5400-rpm (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535811-001

(21) Optical drive (includes bezel)

 DVD-ROM Drive 535815-001

 DVD±RW Double-Layer Drive with LightScribe 535816-001

 Blu-ray ROM DVD+/-RW SuperMulti DL Drive 535817-001

(22) Power button board (includes cable)  

 For use in computers with 15.6-in displays 574513-001

 For use in computers with 14.0-in displays 574514-001

(23) Battery  

 8-cell, 63-Wh for use in computers with 15.6-in displays 535753-001

 6-cell, 47-Wh for use in computers with 15.6-in displays 536418-001

 6-cell, 47-Wh for use in computers with 14.0-in displays 572032-001

 Rubber Kit (not illustrated, contains 8 computer feet and 8 display bezel screw covers) 535793-001
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Display assembly components

Item Description Spare part number

(1) Display bezel

 For use in computers with 15.6-in displays with a webcam 536421-001

 For use in computers with 15.6-in displays without a webcam 536424-001

 For use in computers with 14.0-in displays with a webcam 536423-001

 For use in computers with 14.0-in displays without a webcam 536422-001

(2) Display Hinge Kit  

 For use in computers with 15.6-in displays 535872-001
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Item Description Spare part number

 For use in computers with 14.0-in displays 535871-001

(3) Webcam module 535797-001

 Display Cable Kit  

 For use in computers with 15.6-in HD displays 536433-001

 For use in computers with 14.0-in displays 536430-001

(4a) Microphone cable  

(4b) WLAN antenna receivers and cables  

(4c) WWAN antenna receivers and cables  

(4d) Display/webcam cable  

 Display/webcam cable for use in computers with 15.6-in HD+displays

NOTE: This spare includes only the cable.

536432-001

 Display/webcam cable for use in computers with 14.0-in HD displays

NOTE: This spare includes only the cable.

536429-001

(5) Display enclosure

 For use in black computers with 15.6-in displays 536426-001

 For use in red computers with 15.6-in displays 572724-001

 For use in black computers with 14.0-in displays 536425-001

 For use in red computers with 14.0-in displays 572723-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 535780-001

(1) ExpressCard slot bezel

(2) Optical drive bezel
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Cable Kit

Item Description Spare part number

 Cable Kit

 For use only with computers with 14.0-in displays 536538-001

 For use only with computers with 15.6-in displays 536539-001

(1) TouchPad cable

(2) RJ-45 (network) cable

(3) Bluetooth cable

(4) Power button board and cable

(5) USB cable

(6) Power cable

(7) RJ-11 (modem) jack cable
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Mass storage devices

Item Description Spare part number

(1) Hard drives (include bracket)

 500-GB, 7200-rpm 575125-001

 500-GB, 5400-rpm 535814-001

 320-GB, 7200-rpm 575124-001

 320-GB, 5400-rpm (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535813-001

 250-GB, 7200-rpm 536783-001

 250-GB, 5400-rpm (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535812-001

 160-GB, 7200-rpm 536782-001

 160-GB, 5400-rpm (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535811-001

(2) Optical drives (include bezel)

 DVD-ROM Drive 535815-001

 DVD±RW Double-Layer Drive with LightScribe 535816-001

 Blu-ray ROM DVD+/-RW SuperMulti DL Drive 535817-001

44 Chapter 3   Illustrated parts catalog



Miscellaneous parts
Description Spare part number

AC adapters

65-W AC adapter 463958-001

90-W AC adapter (for use in all countries and regions except India) 463955-001

90-W non-PFC AC adapter (for use only in India) 463956-001

90-W PFC AC adapter (for use only in India) 535593-001

Power cords:

For use in the United States 246959-001

For use in Australia and New Zealand 246959-011

For use in Europe, the Middle East, and Africa 246959-021

For use in the United Kingdom 246959-031

For use in Italy 246959-061

For use in Denmark 246959-081

For use in Switzerland 246959-AG1

For use in Brazil 246959-201

For use in Japan 246959-291

For use in Taiwan 394279-AB1

For use in South Korea 246959-AD1

For use in Israel 246959-BB1

Screw Kit 535870-001

Screw kits include:

● Phillips PM2.0×2.0 screw

● Phillips PM2.0×3.0 screw

● Phillips PM2.0×4.0 screw

● Phillips PM2.5×6.0 screw

● Phillips PM2.5×11.0 captive screw

● Phillips PM3.0×4.0 screw

● Phillips PM2.0×4.0 screw

● Phillips PM2.5×3.0 screw

● Phillips PM2.5×4.5 screw

● Phillips PM2.5×3.0 broadhead screw

● Phillips PM2.5×7.0 screw

● Phillips PM2.5×9.0 captive screw
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Sequential part number listing
Spare part
number

Description

246959-001 Power cord for use in the United States

246959-011 Power cord for use in Australia and New Zealand

246959-021 Power cord for use in Europe, the Middle East, and Africa

246959-031 Power cord for use in the United Kingdom

246959-061 Power cord for use in Italy

246959-081 Power cord for use in Demanrk

246959-201 Power cord for use in Brazil

246959-291 Power cord for use in Japan

246959-AD1 Power cord for use in Korea

246959-AG1 Power cord for use in Switzerland

246959-BB1 Power cord for use in Israel

394279-AB1 Power cord for use in Taiwan

398393-002 Bluetooth module for use only in models with the following system boards: 535803-001, 574505-001,
574506-001

463955-001 90-W AC adapter (for use in all countries except for India)

463956-001 90-W non-PFC NPFC AC adapter (for use in India)

463958-001 65-W AC adapter

449137-001 RTC battery

483377-002 WWAN module for use in all countries and regions except China

504593-003 Broadcom 4312AG 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico,
the U.S. Virgin Islands, and the United States

504593-004 Broadcom 4312AG 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia and Herzegovina, Botswana, Brazil,
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Cayman
Islands, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Guadeloupe, Guam, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast, Jamaica,
Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal, Puerto
Rico, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi
Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

46 Chapter 3   Illustrated parts catalog



Spare part
number

Description

504664-001 Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada, the
Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504664-002 Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

506052-001 AMD Athlon QL-62, 2.0-GHz processor with 1-GB L2 cache (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

507974-001 AMD Turion Ultra ZM-86, 2.4-GHz processor with 2-GB L2 cache (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

507975-001 AMD Turion Ultra ZM-84, 2.3-GHz processor with 2-GB L2 cache (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

507977-001 AMD Turion RM-70, 2.0-GHz processor with 1-GB L2 cache (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

507978-001 AMD Turion RM-72, 2.1-GHz processor with 1-GB L2 cache (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

507979-001 AMD Turion RM-74, 2.2-GHz processor with 1-GB L2 cache (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

508102-001 AMD Sempron SI-42, 2.1-GHz processor with 512-KB L2 cache (for use only with the following system boards:
585218-001, 585219-001, 585220-001, 585221-001)

510100-001 Modem module for use in all countries and regions except Australia and New Zealand

510100-011 Modem module for use in Australia and New Zealand

531993-001 WWAN module, including GPS, UNDP (United Nations Development Program)(not available with Linux)

535593-001 90-W PFC AC adapter (for use only in India)

535766-001 Fan

535780-001 Plastics Kit

535793-001 Rubber Kit

535797-001 Webcam module

535803-001 System board for use in computers with a WWAN module and discrete graphics subsystem memory that use
AMD ZM, RM, QL, or SI processors
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Spare part
number

Description

535804-001 Heat sink for use in computers with UMA graphics subsystems

535805-001 Heat sink for use in computers with discrete graphics subsystems

536418-001 6-cell, 47-Wh Li-ion battery for use in computers with 15.6-in displays

535753-001 8-cell, 63-Wh Li-ion battery for use in computers with 15.6-in displays

535809-001 1-GB memory module (PC2-6400,800-MHz, DDR2)

535810-001 2-GB memory module (PC2-6400,800-MHz, DDR2)

535811-001 160-GB, 5400-rpm hard drive (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535812-001 250-GB, 5400-rpm hard drive (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535813-001 320-GB, 5400-rpm hard drive (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535814-001 500-GB, 5400-rpm hard drive

535815-001 DVD-ROM Drive (includes bezel)

535817-001 Blu-ray ROM DVD+/-RW SuperMulti DL Drive (includes bezel) 

535816-001 DVD±RW Double-Layer Drive with LightScribe (includes bezel)

535860-001 Switch cover for use in black computers with 14.0-in displays

535861-001 Switch cover for use in black computers with 15.6-in displays

535862-001 Optical drive connector

535863-001 Base enclosure for use in computers with 14.0-in displays

535864-001 Base enclosure for use in computers with 15.6-in displays

535865-001 Top cover for use in computers with 14.0-in displays

535866-001 Top cover for use in computers with 15.6-in displays

535867-001 Palm rest for use in black computers with 14.0-in displays (includes TouchPad)

535868-001 Palm rest for use in black computers with 15.6-in displays (includes TouchPad)

535870-001 Screw Kit

535871-001 Display Hinge Kit for use in computers with 14.0-in displays

535872-001 Display Hinge Kit for use in computers with 15.6-in displays

536410-001 Keyboard for use in the United States on computers with 14.0-in displays

536410-121 Keyboard for use in French Canada on computers with 14.0-in displays

536410-161 Keyboard for use in Latin America on computers with 14.0-in displays

536410-201 Keyboard for use in Brazil on computers with 14.0-in displays

536410-281 Keyboard for use in Thailand on computers with 14.0-in displays

536410-291 Keyboard for use in Japan on computers with 14.0-in displays

536410-AB1 Keyboard for use in Taiwan on computers with 14.0-in displays
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Spare part
number

Description

536410-AD1 Keyboard for use in Korea on computers with 14.0-in

536420-001 Speakers for use in computers with 14.0-in displays

536421-001 Display bezel for use on computers with 15.6-in displays with a webcam

536422-001 Display bezel for use on computers with 14.0-in displays without a webcam

536423-001 Display bezel for use on computers with 14.0-in displays with a webcam

536424-001 Display bezel for use on computers with 15.6-in display without a webcam

536425-001 Display enclosure for use on black computers with 14.0-in displays

536426-001 Display enclosure for use in black computers with 15.6-in displays

536429-001 Display cable for use in computers with 14.0-in displays

536430-001 Display Cable Kit for use in computers with 14.0-in displays

536432-001 Display cable for use in computers with 15.6-in HD+ displays

536433-001 Display Cable Kit for use in computers with 15.6-in HD displays

536537-001 Keyboard for use in the United States on computers with 15.6-in displays

536537-031 Keyboard for use in the United Kingdom on computers with 15.6-in displays

536537-041 Keyboard for use in Germany on computers with 15.6-in displays

536537-051 Keyboard for use in France on computers with 15.6-in displays

536537-061 Keyboard for use in Italy on computers with 15.6-in displays

536537-071 Keyboard for use in Spain on computers with 15.6-in displays

536537-081 Keyboard for use in Denmark on computers with 15.6-in displays

536537-091 Keyboard for use in Norway on computers with 15.6-in displays

536537-121 Keyboard for use in French Canada on computers with 15.6-in displays

536537-131 Keyboard for use in Portugal only on computers with 15.6-in displays

536537-141 Keyboard for use in Turkey only on computers with 15.6-in displays

536537-161 Keyboard for use in Latin America on computers with 15.6-in displays

536537-171 Keyboard for use in Saudi Arabia on computers with 15.6-in displays

536537-201 Keyboard for use in Brazil on computers with 15.6-in displays

536537-211 Keyboard for use in Hungary on computers with 15.6-in displays

536537-221 Keyboard for use in the Czech Republic on computers with 15.6-in displays

536537-231 Keyboard for use in Slovakia on computers with 15.6-in displays

536537-251 Keyboard for use in Russia on computers with 15.6-in displays)

536537-261 Keyboard for use in Bulgaria on computers with 15.6-in displays

536537-281 Keyboard for use in Thailand on computers with 15.6-in displays

536537-291 Keyboard for use in Japan on computers with 15.6-in displays
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536537-A41 Keyboard for use in Europe on computers with 15.6-in displays

536537-AB1 Keyboard for use in Taiwan on computers with 15.6-in displays

536537-AD1 Keyboard for use in South Korea on computers with 15.6-in displays

536537-B31 Keyboard for International use on computers with 15.6-in displays

536537-B71 Keyboard for use in Europe on computers with 15.6-in displays

536537-BA1 Keyboard for Slovenia use on computers with 15.6-in displays

536537-BB1 Keyboard for use in Israel on computers with 15.6-in displays

536537-BG1 Keyboard for use in Switzerland on computers with 15.6-in displays

536537-DD1 Keyboard for use in Iceland on computers with 15.6-in displays

536537-DJ1 Keyboard for use in Greece on computers with 15.6-in displays

536538-001 Cable Kit for use in computers with 14.0-in displays

536539-001 Cable Kit for use in computers with 15.6-in displays

536598-001 Speakers for use in computers with 15.6-in displays

536599-001 SIM

536782-001 160-GB, 7200-rpm hard drive

536783-001 250-GB, 7200-rpm hard drive

536784-001 14.0-in AntiGlare display assembly for use in black computers not equipped with a webcam

536785-001 14.0-in AntiGlare display assembly for use in black computers equipped with a webcam

536786-001 14.0-in BrightView display assembly for use in black computers not equipped with a webcam

536787-001 14.0-in BrightView display assembly for use in black computers equipped with a webcam

536790-001 15.6-in AntiGlare display assembly for use in black computers not equipped with a webcam

536791-001 15.6-in AntiGlare display assembly for use in black computers equipped with a webcam

536792-001 15.6-in BrightView display assembly for use in black computers not equipped with a webcam

536793-001 15.6-in BrightView display assembly for use in black computers equipped with a webcam

536794-001 15.6-in AntiGlare display assembly for use in black computers equipped with a webcam and WWAN module

536795-001 15.6-in BrightView display assembly for use in black computers equipped with a webcam and WWAN module

537921-001 Bluetooth module, WPAN (for use only in models with the following system boards: 585218-001, 585219-001,
585220-001, 585221-001)

571888-001 WWAN module for use in China

572032-001 6-cell, 47-Wh Li-ion battery for use in computers with 14.0-in displays

572723-001 Display enclosure for use in red computers with 14.0-in displays

572724-001 Display enclosure for use in red computers with 15.6-in displays

572725-001 Switch cover for use in red computers with 14.0-in displays

572726-001 Switch cover for use in red computers with 15.6-in displays
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572727-001 Palm rest for use in red computers with 14.0-in displays (includes TouchPad)

572728-001 Palm rest for use in red computers with 15.6-in displays (includes TouchPad)

572747-001 AMD Athlon QL-66, 2.2-GHz processor with 1-GB L2 cache (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

572748-001 AMD Turion RM-76, 2.3-GHz processor with 1-GB L2 cache (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

572932-001 14.0-in AntiGlare display assembly for use in red computers not equipped with a webcam

572933-001 14.0-in AntiGlare display assembly for use in red computers equipped with a webcam

572934-001 14.0-in BrightView display assembly for use in red computers not equipped with a webcam

572935-001 14.0-in BrightView display assembly for use in red computers equipped with a webcam

572936-001 15.6-in AntiGlare display assembly for use in red computers not equipped with a webcam

572937-001 15.6-in AntiGlare display assembly for use in red computers equipped with a webcam

572938-001 15.6-in BrightView display assembly for use in red computers not equipped with a webcam

572939-001 15.6-in BrightView display assembly for use in red computers equipped with a webcam

572940-001 15.6-in AntiGlare display assembly for use in red computers equipped with a webcam and WWAN module

572941-001 15.6-in BrightView display assembly for use in red computers equipped with a webcam and WWAN module

574505-001 System board for use in computers with UMA graphics subsystem memory that do not include a WWAN module
that use AMD ZM, RM, QL, or SI processors

574506-001 System board for use in computers with discrete graphics subsystem memory that do not include a WWAN
module that use AMD ZM, RM, QL, or SI processors

574513-001 Power button board for use in computers with 15.6-in displays (includes cable)

574514-001 Power button board for use in computers with 14.0-in displays (includes cable)

575124-001 320-GB, 7200-rpm hard drive

575125-001 500-GB, 7200-rpm hard drive

576251-001 AMD Sempron M100, 2.0-GHz processor with 512-GB L2 cache (for use only with the following system boards:
585218-001, 585219-001, 585220-001, 585221-001)

576252-001 AMD Athlon II M320, 2.1-GHz processor with 1-MB L2 cache (for use only with the following system boards:
585218-001, 585219-001, 585220-001, 585221-001)

576253-001 AMD Turion II Ultra M500, 2.2-GHz processor with 1-MB L2 cache (for use only with the following system
boards: 585218-001, 585219-001, 585220-001, 585221-001)

576254-001 AMD Turion II Ultra M600, 2.4-GHz processor with 2-MB L2 cache (for use only with the following system
boards: 585218-001, 585219-001, 585220-001, 585221-001)

578024-001 AMD Athlon II M300, 2.0-GHz processor with 1-MB L2 cache (for use only with the following system boards:
585218-001, 585219-001, 585220-001, 585221-001)

578366-001 14.0-in HD BrightView display assembly for use in black computers equipped with a webcam and WWAN
module

583055-001 AMD Turion II Ultra M520, 2.3-GHz processor with 1-MB L2 cache (for use only with the following system
boards: 585218-001, 585219-001, 585220-001, 585221-001)
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585218-001 System board for use in computers with a WWAN module and UMA graphics subsystem memory that use
AMD Mxxx processors

585219-001 System board for use in computers without a WWAN module and UMA graphics subsystem memory that use
AMD Mxxx processors

585220-001 System board for use in computers with a WWAN module and discrete graphics subsystem memory that use
AMD Mxxx processors

585221-001 System board for use in computers without a WWAN module and discrete graphics subsystem memory that
use AMD Mxxx processors
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This section provides removal and replacement procedures.

There are as many as 121 screws, in 12 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and support
for the computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 535793-001. There are 8 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number

8-cell, 63-Wh Li-on battery for use in computers with 15.6-in displays 535753-001

6-cell, 47-Wh Li-on battery for use in computers with 15.6-in displays 536418-001

6-cell, 47-Wh Li-on battery for use in computers with 14.0-in displays 572032-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Switch cover and keyboard

Description Spare part number

Switch covers

For use in black computers with 15.6-in displays 535861-001

For use in red computers with 15.6-in displays 572726-001

For use in black computers with 14.0-in displays 535860-001

For use in red computers with 14.0-in displays 572725-001

Keyboards for use in computers with 15.6-in displays 536537-xxx

Keyboards for use in computers with 14.0-in displays 536410-xxx

NOTE: For a detailed list of available keyboards, see Sequential part number listing on page 46.

Before removing the switch cover and keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

Remove the switch cover and keyboard:

1. Position the computer right-side up with the front toward you.

Component replacement procedures 61



2. To remove the switch cover on 15.6-in models, remove the following screws:

(1) Two screw covers and two PM2.5×3.0 screws

(2) Five PM2.5×3.0 broadhead screws (15.6-in models)

(3) Two PM2.0×3.0 screws

– or –

To remove the switch cover on 14.0-in models, remove the following screws:

(1) Two screw covers and two PM2.5×3.0 screws

(2) Two PM2.5×3.0 broadhead screws

(3) Two PM2.0×3.0 screws

3. Turn the computer right-side up and open the computer as far as possible.

62 Chapter 4   Removal and replacement procedures



4. Slide the switch cover back (1), and then lift it off the computer (2).

5. On computers with 15.6-in displays, remove the two Phillips PM2.5×3.0 screws that secure the
keyboard to the computer.

– or –

On computers with 14.0-in displays, remove the three Phillips PM2.5×3.0 screws that secure the
keyboard to the computer.
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6. Slide the keyboard back toward the display (1), and then rotate it forward (2) to gain access to the
keyboard cable connector.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the switch cover and keyboard.
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Memory module

Description Spare part number

2-GB (PC2-6400, 800-MHz, DDR2) 535810-001

1-GB (PC2-6400,800-MHz, DDR2) 535809-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 61).

Remove the memory module:

1. Position the computer right-side up with the front toward you.

2. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

3. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Optical drive
NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number

DVD±RW Double-Layer Drive with LightScribe 535816-001

Blu-ray ROM DVD+/-RW SuperMulti DL Drive 535817-001

DVD-ROM Drive 535815-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 61).

Remove the optical drive:

1. Position the computer with the right side toward you.

2. Remove the Phillips PM2.5×7.0 screw (1) that secures the optical drive to the computer.

NOTE: On 15.6-in models, the screw is located in a hole in the top cover.

NOTE: On 14.0-in models, the screw is located directly below the keyboard ZIF connector. The
screw is not located in a hole in the top cover.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the right to release the optical drive from the computer.
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4. Remove the optical drive (3) from the computer.

NOTE: 15.6-in model shown below

NOTE: 14.0-in model shown below

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.

6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.
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7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Speakers

Description Spare part number

For use in computers with 15.6-in displays 536598-001

For use in computers with 14.0-in displays 536420-001

Before removing the speaker, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 61).

Remove the speakers:

1. Position the computer right-side up with the front toward you.

2. Disconnect the speaker cable (1) from the system board.

NOTE: The two speakers are connected with a single cable.

3. Remove the four Phillips PM2.5×3.0 screws (2) that secure the speakers to the top cover.

4. Remove the speaker cable from the clips and routing channel, and then remove the speakers from
the computer (3).

Reverse this procedure to install the speakers.
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WWAN module

Description Spare part number

WWAN module for use in all countries and regions except China 483377-002

WWAN module for use in China 571888-001

WWAN module, including GPS, UNDP (United Nations Development Program; not available with
Linux)

531993-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact technical support through Help and Support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 61)

To remove the WWAN module:

1. Position the computer right-side up with the front toward you.

2. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

3. Remove the two Phillips PM2.5×3.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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4. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.

Palm rest

Description Spare part number

Palm rest for use in black computers with 15.6-in displays (includes TouchPad) 535868-001

Palm rest for use in red computers with 15.6-in displays (includes TouchPad) 572728-001

Palm rest for use in black computers with 14.0-in displays (includes TouchPad) 535867-001

Palm rest for use in red computers with 14.0-in displays (includes TouchPad) 572727-001

Before removing the palm rest, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 61)

To remove the palm rest:

1. Position the computer right-side up with the front toward you.
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2. On 15.6-in models:

a. Remove the two Phillips PM2.5×3.0 broadhead screws (1) that secure the palm rest to the
computer.

b. Slide the palm rest back toward the display (2), and then lift and rotate the front edge (3) to
gain access to the TouchPad cable.

– or –

On 14.0-in models:

a. Remove the three Phillips PM2.5×3.0 broadhead screws (1) that secure the palm rest to the
computer.

b. Slide the palm rest back toward the display (2), and then lift the front edge (3) to gain access
to the TouchPad cable.
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3. Release the ZIF connector (1) to which the TouchPad cable is connected, and then disconnect the
TouchPad cable (2) from the system board.

4. Remove the palm rest.

Reverse this procedure to install the palm rest.
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Hard drive
NOTE: The hard drive spare part kit includes a hard drive bracket.

Description Spare part number

500-GB, 7200-rpm hard drive (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

575125-001

500-GB, 5400-rpm hard drive 535814-001

320-GB, 7200-rpm hard drive 575124-001

320-GB, 5400-rpm hard drive (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535813-001

250-GB, 7200-rpm hard drive 538972-001

250-GB, 5400-rpm hard drive (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

535812-001

160-GB, 7200-rpm hard drive 536782-001

160-GB, 5400-rpm hard drive 535811-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Palm rest (see Palm rest on page 71)

Remove the hard drive:

1. Position the computer right-side up with the front toward you.

2. Remove the two Phillips PM2.0×4.0 screws (1) and loosen the Phillips PM2.5×11.0 captive screw
(2) that secures the hard drive to the computer.

3. Grasp the Mylar tab on the hard drive and slide the hard drive (3) to the left to disconnect it from
the system board.
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4. Remove the hard drive (4) from the hard drive bay.

5. If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×4.0 hard drive
bracket screws (1) from each side of the hard drive.

6. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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WLAN module

Description Spare part number

Broadcom 4322 802.11a/b/g/n WLAN modules:

● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504664-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504664-002

Broadcom BCM4312 802.11b/g WLAN modules:

● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504593-003

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004
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Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Palm rest (see Palm rest on page 71)

Remove the WLAN module:

1. Position the computer right-side up with the front toward you.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

3. Remove the two Phillips PM2.5×3.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

4. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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Display assembly on computers with 15.6-in displays
NOTE: For information about removing the display from 14.0-in models, see Display assembly on
computers with 14.0-in displays on page 91.

NOTE: The display assembly spare part kit includes 2 WLAN antenna transceivers and cables.

Description Spare part number

For use only with black computers with 15.6-in HD displays

AntiGlare display assembly for use in computers not equipped with a webcam 536790-001

AntiGlare display assembly for use in models equipped with a webcam 536791-001

AntiGlare display assembly for use in computers equipped with a webcam and WWAN module 536794-001

BrightView display assembly for use in computers not equipped with a webcam 536792-001

BrightView display assembly for use in computers equipped with a webcam 536793-001

BrightView display assembly for use in computers equipped with a webcam and WWAN module 536795-001

For use only with red computers with 15.6-in HD displays  

AntiGlare display assembly for use in computers not equipped with a webcam 572936-001

AntiGlare display assembly for use in computers equipped with a webcam 572937-001

AntiGlare display assembly for use on computers equipped with a webcam and WWAN module 572940-001

BrightView display assembly for use in computers not equipped with a webcam 572938-001

BrightView display assembly for use in computers equipped with a webcam 572939-001

BrightView display assembly for use in computers with a webcam and WWAN module 572941-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact technical support through Help and Support.

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Speakers (see Speakers on page 69)
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Remove the display cables:

1. Position the computer right-side up with the front toward you.

2. Open the computer as far as possible.

3. Disconnect the display panel/webcam cable assembly (1) from the system board.

4. Remove the microphone module cable from the routing path (2), and then disconnect the cable
(3) from the system board.

5. Remove the WLAN wireless antenna cables (4) from the tape, clips and routing channels built into
the top cover.

6. On models with a WWAN module, remove the WWAN wireless antenna cables (5) from the tape,
clips and routing channels built into the top cover.

Remove the display assembly:

CAUTION: Support the display assembly when removing the following screws. Failure to support the
display assembly can result in damage to the display assembly and other computer components.

1. Remove the six Phillips PM2.5×6.0 screws (1) that secure the display assembly to the computer.

2. Lift the display assembly (2) straight up and remove it.
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3. If it is necessary to replace the display bezel, display enclosure, or display hinges, remove the eight
rubber screw covers (1) and the eight Phillips PM2.0×6.0 screws (2) that secure the display bezel
to the display assembly. The rubber screw covers are available in the Rubber Kit, spare part number
535793-001.

4. Remove the bezel:

a. Flex the top of the bezel until it disengages from the display enclosure (1).

b. Flex the inside bottom of the bezel until it disengages from the display enclosure (2).

c. Flex the outside bottom of the bezel until it disengages from the display enclosure (3).

d. Lift the bottom corners of the bezel until they disengage from the display enclosure (4).

e. Lift the bezel at the seam in the hinges until it disengages from the display enclosure (5).

f. Remove the bezel from the display enclosure.

The display bezel is available using spare part number 536421-001 on computers with 15.6-in
displays and a webcam and 536424-001 for computers with 15.6-in displays and no webcam.
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5. If it is necessary to replace the webcam module from the display enclosure, gently pull the webcam
module away from the double-sided tape on the display enclosure (1), disconnect the webcam
cable from the module (2), and then remove the webcam. The webcam module is available using
spare part number 535797-001.

NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.

6. If it is necessary to replace the display hinges:

a. Remove the display panel by removing the four Phillips PM2.5×4.5 screws (1) that secure the
panel to the display enclosure.

b. Lift the panel from the enclosure (2).

c. Remove the eight Phillips PM2.0×3.0 screws (1) that secure the display hinges to the display
panel.
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d. Remove the display hinges (2). The left and right display hinges are available in the Display
Hinge Kit, spare part number 535872-001 for computers with 15.6-in displays.

7. If it is necessary to replace the display/webcam cable:

NOTE: The display cable and webcam cable are bound together as one cable assembly.

a. On the back of the display panel, peel back the tape that secures the display cable to the
display panel (1), and then disconnect the cable from the connector on the back of the display
panel (2).

b. Gently pull the webcam cable (1) from the clips and routing channels (2) built into the top
cover. The display/webcam cable is included in the Display Cable Kit, spare part numbers
536433-001 for computers with 15.6-in HD displays and 536432-001 for computers with 15.6-
in HD+ displays.
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Reverse this procedure to reassemble and install the display assembly.
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Top cover
NOTE: The top cover removal procedures differ for 15.6-in computers from those of 14.0-in computers.

NOTE: You must remove the top cover before you can remove the display assembly on computers
with 14.0-in displays. You do not have to remove the top cover to remove the display assembly on
computers with 15.6-in displays.

Description Spare part number

Top cover for use in computers with 15.6-in displays 535866-001

Top cover for use in computers with 14.0-in displays 535865-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Speakers (see Speakers on page 69)

c. Palm rest (see Palm rest on page 71)

Remove the top cover:

NOTE: Steps 1 through 5 illustrate how to remove the top cover from computers with 15.6-in displays.
Steps 6 through 10 illustrate how to remove the top cover from computers with 14.0-in displays.

1. Position the computer right-side up with the front toward you.
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2. Disconnect the power button board cable from the system board by releasing the ZIF connector
(1), and then disconnecting the cable (2).

3. Remove the 19 Phillips PM2.5×6.0 screws that secure the top cover to the computer.

4. Remove the two Phillips PM2.0×4.0 screws (1) and the three Phillips PM2.0×2.0 screws (2) that
secure the top cover to the computer.
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5. Lift the front edge (1) of the top cover until it disengages from the base enclosure, release the top
cover from the sides and rear of the base enclosure, and then remove the top cover (2).

6. Remove the top cover.

NOTE: Steps 6 through 10 illustrate how to remove the top cover from computers with 14.0-in
displays. Steps 1 through 5 illustrate how to remove the top cover from computers with 15.6-in
displays.

7. Position the computer right-side up with the front toward you.

8. Disconnect the display panel cable (1) from the system board.

9. Remove the microphone module cable from the routing path (2), and then disconnect the cable
(3) from the system board.

10. Remove the WLAN wireless antenna cables (4) and WWAN wireless antenna cables (5) from the
clips and routing channels built into the top cover.
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11. Remove the 21 PM2.5×6.0 screws that secure the top cover to the computer.

NOTE: Two of these screws (one of each side) also secure the display panel to the computer.

12. Remove the Phillips PM2.0×4.5 screw that secures the top cover to the computer.

13. Lift the top cover until is disengages from the base enclosure (1). Locations at which the top cover
more securely connects to the base enclosure are indicated by callout (2).

14. Remove the top cover.

Reverse this procedure to install the top cover.
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Power button board

Description Spare part number

Power button board for use in computers with 15.6-in displays (includes cable) 574513-001

Power button board for use in computers with 14.0-in displays (includes cable) 574514-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Optical drive (see Optical drive on page 66)

c. Speakers (see Speakers on page 69)

d. Palm rest (see Palm rest on page 71)

e. Hard drive (see Hard drive on page 74)

f. Top cover (see Top cover on page 84)

g. Display assembly (see Display assembly on computers with 15.6-in displays on page 78 or
Display assembly on computers with 14.0-in displays on page 91)

To remove the power button board:

1. Position the top cover upside down with the rear toward you.
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2. Lift the board straight up and off the top cover.

NOTE: Computer with 15.6-in display shown.

Reverse this procedure to install the power button board.
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RTC battery

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Palm rest (see Palm rest on page 71)

c. Top cover on 14.0-in models (see Top cover on page 84)

Remove the RTC battery:

1. Position the computer right-side up with the front toward you.

2. Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery.
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Display assembly on computers with 14.0-in displays
NOTE: For information about removing the display from 15.6-in models, see Display assembly on
computers with 15.6-in displays on page 78.

NOTE: The display assembly spare part kit includes two WLAN antenna transceivers and cables.

Description Spare part number

For use only with black computers with 14.0-in HD displays

AntiGlare display assembly for use in computers not equipped with a webcam 536784-001

AntiGlare display assembly for use in computers equipped with a webcam 536785-001

BrightView display assembly for use in computers not equipped with a webcam 536786-001

BrightView display assembly for use in computers equipped with a webcam 536787-001

BrightView display assembly for use in computers equipped with a webcam and WWAN module 578366-001

For use only with red computers with 14.0-in HD displays  

AntiGlare display assembly for use in computers not equipped with a webcam 572932-001

AntiGlare display assembly for use in computers equipped with a webcam 572933-001

BrightView display assembly for use in computers not equipped with a webcam 572934-001

BrightView display assembly for use in computers equipped with a webcam 572935-001

Before removing the 14.0-in display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Optical drive (see Optical drive on page 66)

c. Speakers (see Speakers on page 69)

d. Top cover (see Top cover on page 84)

e. Palm rest (see Palm rest on page 71)

Remove the 14.0-in display assembly:

1. Position the computer right-side up with the front toward you.

2. Open the computer as far as possible.

3. Remove the four Phillips PM2.5×4.5 screws (1) that secure the display assembly to the computer.
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NOTE: When replacing the display assembly, only replace the four bottom screws in the display
brackets. The top screw on the bracket on each side is replaced when you install the top cover.

4. Lift the display assembly up and off the computer (2).

5. If it is necessary to replace the display bezel, display enclosure, or display hinges, remove the eight
rubber screw covers (1) and the eight Phillips PM2.5×6.0 screws (2) that secure the display bezel
to the display assembly. The rubber screw covers are available in the Rubber Kit, spare part number
535793-001.

6. To remove the bezel:

a. Flex the top of the bezel until it disengages from the display enclosure (1).

b. Flex the inside bottom of the bezel until it disengages from the display enclosure (2).

c. Flex the outside bottom of the bezel until it disengages from the display enclosure (3).

d. Lift the bottom corners of the bezel until they disengage from the display enclosure (4).
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e. Lift the bezel at the seam in the hinges until it disengages from the display enclosure (5).

f. Remove the bezel from the display enclosure.

The display bezel is available using spare part numbers 536423-001 on computers with 14.0-in
displays and a webcam and 536422-001 on computers with 14.0-in displays and no webcam.

7. If it is necessary to replace the webcam module from the display enclosure, gently pull the webcam
module away from the double-sided tape on the display enclosure (1) and disconnect the webcam
cable from the module (2). The webcam module is available using spare part number
535797-001.

NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.

8. If it is necessary to replace the display hinges:

a. Remove the display panel by removing the two Phillips PM2.5×4.5 screws (1) that secure the
panel to the display enclosure.

Component replacement procedures 93



b. Lift the bottom of the panel (2) to remove it from the enclosure.

c. Remove the six Phillips PM2.0×3.0 screws (1) that secure the display hinges to the display
panel.

d. Remove the display hinges (2). The left and right display hinges are available in the Display
Hinge Kit, spare part number 535871-001 for computers with 14.0-in displays.
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9. If it is necessary to replace the webcam cable from the display enclosure, gently pull the webcam
cable (1) from the clips and routing channels (2) built into the top cover. The webcam cable is
included in the Display Cable Kit, spare part numbers 536430-001 for computers with 14.0-in
displays.

Reverse this procedure to install the display assembly.
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Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 536539-001 for computers with 15.6-in
displays, 536538-001 for computers with 14.0-in displays. See Cable Kit on page 43 for more Cable Kit
spare part number information.

Description Spare part number

Bluetooth module, Broadcom (for use only in models with the following system boards: 535803-001,
574505-001, 574506-001)

398393-002

Bluetooth module, WPAN (for use only in models with the following system boards: 585218-001,
585219-001, 585220-001, 585221-001)

537921-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Palm rest (see Palm rest on page 71)

c. Hard drive (see Hard drive on page 74)

Remove the Bluetooth module:

1. Position the computer right-side up with the front toward you.

2. Disconnect the Bluetooth module cable from the system board (1).

3. Remove the Bluetooth module cable from the routing path (2).
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4. Remove the Bluetooth module (3) from the base enclosure.

Reverse this procedure to install the Bluetooth module.

Modem module

Description Spare part number

For use in all countries and regions except Australia and New Zealand 510100-001

For use only in Australia and New Zealand 510100-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Optical drive (see Optical drive on page 66)

c. Speakers (see Speakers on page 69)

d. Palm rest (see Palm rest on page 71)

e. Top cover (see Top cover on page 84)
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Remove the modem module:

1. Position the computer right-side up with the front toward you.

2. Remove the two Phillips PM2.5×3.0 screws (1) that secure the modem module to the system board.

3. Lift the modem module (2) straight up to disconnect it from the system board.

4. Remove the tape (3) that secures the cable to the modem module, and then disconnect the modem
module cable (4).

5. Remove the modem module.

Reverse this procedure to install the modem module.

USB connector assembly
NOTE: The USB connector assembly is included in the Cable Kit, spare part number 536539-001 for
computers with 15.6-in displays or 536538-001 for computers with 14.0-in displays.

Before removing the USB connector assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Optical drive (see Optical drive on page 66)

c. Speakers (see Speakers on page 69)

d. Palm rest (see Palm rest on page 71)
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e. Hard drive (see Hard drive on page 74)

f. Display assembly (see Display assembly on computers with 15.6-in displays on page 78 or
Display assembly on computers with 14.0-in displays on page 91)

g. Top cover (see Top cover on page 84)

Remove the USB connector assembly:

1. Position the computer right-side up with the right side toward you.

2. Disconnect the cable from the system board (1) and remove the cable from the routing path in the
base enclosure (2).

3. Remove the Phillips PM2.5×3.0 screw (3) and the Phillips PM2.5×7.0 screw (4) that secures the
USB connector assembly to the base enclosure.

4. Remove the USB connector assembly (5) from the base enclosure.

Reverse this procedure to install the USB connector assembly.
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Heat sink and fan
NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number

Heat sink for use in computers with UMA graphics subsystems 535804-001

Heat sink for use in computers with discrete graphics subsystems 535805-001

Fan 535766-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Speakers (see Speakers on page 69)

c. Optical drive (see Optical drive on page 66)

d. Palm rest (see Palm rest on page 71)

e. Top cover (see Top cover on page 84)

Remove the heat sink:

NOTE: Steps 1 through 4 apply to computers with discrete subsystem memory on the system board.
Steps 5 through 8 apply to computers with UMA subsystem memory.

1. Position the computer right-side up with the front toward you.

2. Following the sequence stamped into the heat sink, loosen the seven screws (1), (2), (3), (4), (5),
(6), (7) around the processor.

3. Disconnect the fan cable from the system board (8).
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4. Remove the heat sink (9).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system board
(1), (2), and (3), and the heat sink components (4), (5), and (6) each time the heat sink is removed.
Replacement thermal material is included with all heat sink, system board, and processor spare
part kits.

NOTE: Steps 5 through 8 apply to computers with UMA subsystem memory. Steps 1 through 4
apply to computers with discrete subsystem memory.

5. Position the computer right-side up with the front toward you.

6. Following the sequence stamped into the heat sink, loosen the five screws (1), (2), (3), (4), (5)
around the processor.

7. Disconnect the fan cable from the system board (6).
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8. Remove the heat sink (7).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system board
(1) and (2) and the heat sink components (3) and (4) each time the heat sink is removed.
Replacement thermal material is included with all heat sink, system board, and processor spare
part kits.
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9. If it is necessary to remove the fan from the heat sink, remove the three Phillips PM2.0×3.0 screws
(1) that secure the fan to the heat sink, and then remove the fan from the heat sink (2).

Reverse this procedure to install the heat sink.
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Processor
NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

AMD Turion II Ultra Dual-Core processors (for use only with the following system boards:
585218-001, 585219-001, 585220-001, 585221-001)

 

M500 (2.2-GHz with 1-MB L2 cache) 576253-001

M520 (2.3-GHz with 1-MB L2 cache) 583055-001

M600 (2.4-GHz with 2-MB L2 cache) 576254-001

AMD Turion Ultra Dual-Core processors (for use only with the following system boards:
574505-001, 574506-001, 585802-001, 585803-001)

 

ZM-84 (2.3-GHz with 2-GB L2 cache) 507975-001

ZM-86 (2.4-GHz with 2-GB L2 cache) 507974-001

AMD Turion Dual-Core processors (for use only with the following system boards: 574505-001,
574506-001, 585802-001, 585803-001)

 

RM-70 (2.0-GHz with 1-GB L2 cache) 507977-001

RM-72 (2.1-GHz with 1-GB L2 cache) 507978-001

RM-74 (2.2-GHz with 1-GB L2 cache) 507979-001

RM-76 (2.3-GHz with 1-GB L2 cache) 572748-001

AMD Athlon II Dual-Core processors (for use only with the following system boards: 585218-001,
585219-001, 585220-001, 585221-001)

 

M300 (2.0-GHz with 1-MB L2 cache) 578024-001

M320 (2.1-GHz with 1-MB L2 cache) 576252-001

AMD Athlon Dual-Core processors (for use only with the following system boards: 574505-001,
574506-001, 585802-001, 585803-001)

 

QL-62 (2.0-GHz with 1-GB L2 cache) 506052-001

QL-66 (2.2-GHz with 1-GB L2 cache) 572747-001

AMD Sempron processor  

M100 (2.0-GHz with 512-GB L2 cache; for use only with the following system boards: 585218-001,
585219-001, 585220-001, 585221-001)

576251-001

SI-42 (2.1-GHz with 512-KB L2 cache; for use only with the following system boards: 574505-001,
574506-001, 585802-001, 585803-001)

508102-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Optical drive (see Optical drive on page 66)

c. Speakers (see Speakers on page 69)

d. Palm rest (see Palm rest on page 71)

e. Top cover (see Top cover on page 84)

Remove the processor:

1. Position the computer right-side up with the front toward you.

2. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.

3. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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System board
NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

System board for use in computers with a WWAN module that use AMD Mxxx processors  

UMA graphics subsystem memory 585218-001

Discrete graphics subsystem memory 585220-001

System board for use in computers without a WWAN module that use AMD Mxxx processors  

UMA graphics subsystem memory 585219-001

Discrete graphics subsystem memory 585221-001

System board for use in computers with a WWAN module that use AMD ZM, RM, QL, or SI
processors:

 

Discrete graphics subsystem memory 535803-001

System board for use in computers without a WWAN module that use AMD ZM, RM, QL, or
SI processors:

 

UMA graphics subsystem memory 574505-001

Discrete graphics subsystem memory 574506-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Speakers (see Speakers on page 69)

c. WWAN module (see WWAN module on page 70)

d. Palm rest (see Palm rest on page 71)

e. WLAN module (see WLAN module on page 76)

f. Hard drive (see Hard drive on page 74)

g. Optical drive (see Optical drive on page 66)

h. Display assembly (see Display assembly on computers with 15.6-in displays on page 78 or
Display assembly on computers with 14.0-in displays on page 91)

i. Top cover (see Top cover on page 84)
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When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● Memory module (see Memory module on page 65)

● WLAN module (see WLAN module on page 76)

● WWAN module (see WWAN module on page 70)

● Modem module (see Modem module on page 97)

● Processor (see Processor on page 104)

Remove the system board:

1. Position the computer right-side up with the front toward you.

2. Disconnect the following cables from the system board:

● (1) Bluetooth module cable

● (2) USB connector module cable

● (3) RJ-45 cable

● (4) SIM board cable

● (5) Power cable

3. Lift the rear edge of the system board (1) until it rests at an angle.
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4. Remove the system board from the base enclosure (2).

5. (15.6-in models only) If it is necessary to remove the optical drive connector board from the system
board, pull the optical drive connector board straight off the system board. The optical drive
connector board is available using spare part number 535862-001.

Reverse this procedure to install the system board.

SIM

Description Spare part number

SIM 536599-001

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 60).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Optical drive (see Optical drive on page 66)

c. Speakers (see Speakers on page 69)

d. WWAN module (see WWAN module on page 70)

e. Palm rest (see Palm rest on page 71)

f. WLAN module (see WLAN module on page 76)

g. Hard drive (see Hard drive on page 74)

h. Top cover (see Top cover on page 84)

i. Display assembly (see Display assembly on computers with 15.6-in displays on page 78 or
Display assembly on computers with 14.0-in displays on page 91)

j. System board (see System board on page 106)

To remove the SIM:

1. Position the computer right-side up with the front toward you.

2. Remove the two Phillips PM2.5×3.0 screws (1) that secure the SIM to the system board.

3. Remove the SIM (2) by pulling the module straight up and off the computer.

Reverse this procedure to install the SIM.
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5 Computer Setup

Computer Setup in Windows Vista and Windows XP
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.
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NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) ● Create a new BIOS user account.

● View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (disabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (disabled by default).

Allow Reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys.

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the selected
drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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Diagnostics menu

Select To do this

System Diagnostics Menu ● System Information—Displays the following information:

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

● Start-up Test—Verifies the system components needed
for starting the computer.

● Run-In Test—Runs a comprehensive check on system
memory.

● Hard Disk Test—Runs a comprehensive self-test on any
hard drive in the system.

● Error Log—Displays a log file if any errors have
occurred.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (disabled by
default).

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not running.

◦ Startup from bootable USB devices, including a hard
drive, diskette drive, or optical drive connected by a
USB port to the computer.

● Enable/disable fan always on while connected to an AC
outlet (disabled by default).

● Enable/disable Data Execution Prevention (select models
only; disabled by default). When enabled, the processor
can disable some virus code execution, which helps to
improve computer security.

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

NOTE: Availability of the options above varies by
computer model.

● Enable/disable HP QuickLook 2 (enabled by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable Dual-Core CPU (enabled by default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (enabled by default).
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Select To do this

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WWAN device radio (enabled
by default).

● Enable/disable embedded Bluetooth® device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network (set by default)

◦ Follow Boot Order

● Enable/disable the optical disc drive (enabled by
default).

● Enable/disable the microphone.

● Enable/disable a modem device (enabled by default).

● Enable/disable the embedded WLAN device (enabled by
default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Enable/disable the integrated camera (select models
only; enabled by default).

Port Options (all are enabled by default) NOTE: All port options are enabled by default.

● Enable/disable the ExpressCard slot.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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Computer Setup in Linux
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before your operating system opens and while the “F10=ROM Based Setup” message is displayed
in the lower-left corner of the screen, press f10.
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Using Computer Setup

Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File
> Ignore Changes And Exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore Defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer.

● View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults DReplace the configuration settings in Computer Setup with
the original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore Changes And Exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes And Exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup Password Enter, change, or delete a setup password.

Power-On Password Enter, change, or delete a power-on password.

Password Options ● Enable/disable stringent security.

● Enable/disable the password requirement on computer
restart.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive.

● Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk
Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary
hard drive is destroyed permanently.

Diagnostics menu

Select To do this

HDD Self-Test Options Run a comprehensive self-test on any hard drive in the system
or on any optional MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot options ● Set an f9, f10, and f12 delay when starting up.

● Enable/disable CD-ROM boot.

● Enable/disable floppy boot.

● Enable/disable internal network adapter boot.

● Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

◦ 1st boot device: USB CD-ROM

◦ 2nd boot device: USB floppy

◦ 3rd boot device: USB SuperDisk

◦ 4th boot device: Notebook hard drive

◦ 5th boot device: USB hard disk

◦ 6th boot device: Network controller

Device Configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable USB legacy support. When enabled, USB
legacy support allows the following:

◦ Use of a USB keyboard in Computer Setup even
when a your operating system is not running.

◦ Startup from bootable USB devices, including a hard
drive, diskette drive, or optical drive connected by a
USB port to the computer.

● Enable/disable BIOS DMA data transfers.

● Enable/disable fan always on while connected to an AC
outlet.

● Enable/disable data execution prevention.

● Enable/disable LAN power saving mode.

● Enable/disable SATA Native Mode.

● Enable/disable Dual-Core CPU.

● Enable/disable HDD translation mode.
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Select To do this

Built-in device options ● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth Device Radio.

● Enable/disable Network Interface Controller (NIC)

● Enable/disable LAN/WLAN Switching.

● Enable/disable Wake on LAN.

● Enable/disable the integrated camera (webcam)

Port options ● Enable/disable USB port.

● Enable/disable ExpressCard slot.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Depth (14.0-in models) 23.24 cm 9.15 in

Depth (15.6-in models) 24.96 cm 9.83 in

Width (14.0-in models) 33.60 cm 13.2 in

Width (15.6-in models) 37.18 cm 14.6 in

Height (front to rear) (14.0-in models) 3.10 to 3.58 cm 1.24 to 1.41 in

Height (front to rear) (15.6-in models) 3.15 to 3.63 cm 1.24 to 1.43 in

Weight (14.0-in models: 6-cell battery, no WWAN, no camera,
no Bluetooth, no modem, one DIMM, with ODD)

< 2.27 kg < 5.00 lbs

Weight (15.6-in models: 6-cell battery, no WWAN, no camera,
no Bluetooth, no modem, one DIMM, with ODD)

< 2.59 < 5.7 lbs

Input power

Operating voltage 18.5 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine
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 Metric U.S.

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

14.0-in WXGA display specifications
 Metric U.S.

Dimensions   

Height 27.94 cm 11.0 in

Width 20.83 cm 8.2 in

Diagonal 35.56 cm 14.0 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 180 nits (typical)

Pixel resolution   

Pitch 0.279 × 0.279 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4 W

Viewing angle +/-40° horizontal, +20/-40° vertical (typical)
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15.6-in WXGA display specifications
 Metric U.S.

Dimensions

Height 20.7 cm 8.1 in

Width 33.1 cm 13.0 in

Diagonal 39.1 cm 15.6 in

Number of colors Up to 16.8 million

Contrast ratio 300:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.259 × 0.259 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight CCFL

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-30° horizontal, +10/–40° vertical (typical)
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Hard drive specifications
 500-GB* 320-GB* 250-GB* 160-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms

Logical blocks 1,048,576,000 625,141,400 488,376,280 312,560,640

Disc rotational speed 5400 rpm 5400 rpm 7200 and 5400
rpm

7200 and 5400
rpm

Operating temperature  5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW Double-Layer Combo Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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Blu-ray ROM DVD+/-RW SuperMulti DL Drive
Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-
R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HD-
ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW, BD-ROM,
BD-R, BR-RE

CD-R and CD-RW DVD+R, DVD+R (9),
DVD+RW, DVD-R, DVD-R (9), DVD-RW,
DVD-RAM

Access time CD DVD HD

Random 170 ms 170 ms 230 ms

Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

1X BD-ROM 4,500 KB/sec

1X BD-R read 4,500 KB/sec

1X BD-RE read 4,500 KB/sec

Transfer mode Multiword DMA Mode

128 Chapter 6   Specifications



DVD-ROM Drive
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital

Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Access time CD DVD

Random < 100 ms < 125 ms

Cache buffer 512 KB  

Data transfer rate   

CD-R (24X) 3600 KB/sec (150 KB/sec at 1X CD rate)  

CD-RW (10X) 1500 KB/sec (150 KB/sec at 1X CD rate)  

CD-ROM (24X) 3600 KB/sec (150 KB/sec at 1X CD rate)  

DVD (8X) 10,800 KB/sec (1,352 KB/sec at 1X DVD
rate)

 

Transfer Mode Multiword DMA Mode  
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System DMA specifications, Windows Vista and XP
Hardware DMA System function

DMA4 Direct memory access controller

System interrupt specifications, Windows Vista
Hardware IRQ System function

ISA0 System timer

ISA1 Standard 101-/102-Key or Microsoft Natural Keyboard

ISA8 System CMOS/real-time clock

ISA100 - ISA119 Microsoft ACPI-Compliant System

ISA12 Synaptics PS/2 TouchPad

ISA120 - ISA129 Microsoft ACPI-Compliant System

ISA13 Numeric data processor

ISA130 - ISA139 Microsoft ACPI-Compliant System

ISA14 ATA Channel 0

ISA140 - ISA149 Microsoft ACPI-Compliant System

ISA15 ATA Channel 1

ISA150 - ISA190 Microsoft ACPI-Compliant System

ISA23 HP Mobile Data Protection Sensor

ISA81 - ISA99 Microsoft ACPI-Compliant System

PCI16 Intel ICH9 Family USB Universal Host Controller – 2937

PCI16 Mobile Intel 4 Series Express Chipset Family

PCI17 Broadcom 802.11b/g WLAN

PCI17 High Definition Audio Controller

PCI17 Intel ICH9 Family USB Universal Host Controller – 2938

PCI17 Marvell Yukon 88E8072 PCI-E Gigabit Ethernet Controller

PCI18 Intel ICH9 Family USB Universal Host Controller – 2939

PCI18 Intel ICH9 Family USB Universal Host Controller – 2936

PCI18 Standard Dual Channel PCI IDE Controller

PCI19 Intel ICH9 Family USB2 Enhanced Host Controller – 293C

PCI-2 Intel ICH9 Family PCI Express Root Port 1 - 2940

PCI20 Intel ICH9 Family Universal Host Controller – 2934

PCI20 Intel ICH9 Family USB2 Enhanced Host Controller – 293A

PCI22 Intel ICH9 Family Universal Host Controller – 2935
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Hardware IRQ System function

PCI-3 Intel ICH9 Family PCI Express Root Port 2 - 2942

PCI-4 Intel ICH9 Family PCI Express Root Port 3 - 2944

PCI-5 Intel ICH9 Family PCI Express Root Port 5 - 2948

PCI-6 Intel ICH9 Family PCI Express Root Port 6 - 294A

System interrupt specifications, Windows XP
Hardware IRQ System function

ISA0 System timer

ISA1 Standard 101-/102-Key or Microsoft Natural Keyboard

ISA8 System CMOS/real-time clock

ISA9 Microsoft ACPI-Compliant System

ISA12 Synaptics PS/2 TouchPad

ISA13 Numeric data processor

ISA23 HP Mobile Data Protection Sensor

PCI16 Intel ICH9 Family USB Universal Host Controller – 2937

PCI16 Mobile Intel 4 Series Express Chipset Family

PCI17 Broadcom 4322AG 802.11a/b/g/draft-n Wi-Fi Adapter

PCI17 Intel ICH9 Family PCI Express Root Port 1 - 2940

PCI17 Intel ICH9 Family PCI Express Root Port 5 - 2948

PCI17 Intel ICH9 Family USB Universal Host Controller – 2938

PCI17 Marvell Yukon 88E8072 PCI-E Gigabit Ethernet Controller

PCI17 Microsoft UAA Bus Driver for High Definition Audio

PCI18 Intel ICH9 Family PCI Express Root Port 3 - 2944

PCI18 Intel ICH9 Family USB Universal Host Controller – 2939

PCI18 Intel ICH9 Family USB Universal Host Controller – 2936

PCI19 Intel ICH9 Family USB2 Enhanced Host Controller – 293C

PCI20 Intel ICH9 Family Universal Host Controller – 2934

PCI20 Intel ICH9 Family USB2 Enhanced Host Controller – 293A

PCI21 ICH9M-E/M SATA AHCI Controller

PCI22 Intel ICH9 Family Universal Host Controller – 2935
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System I/O address specifications, Windows Vista
I/O address (hex) System function (shipping configuration)

000 - 01F Direct memory access controller

000 - CF7 PCI bus

020 - 021 Programmable interrupt controller

024 - 025 Programmable interrupt controller

028 - 029 Programmable interrupt controller

02C - 02D Programmable interrupt controller

02E - 02F Motherboard resources

030 - 031 Programmable interrupt controller

034 - 035 Programmable interrupt controller

038 - 039 Programmable interrupt controller

03C - 03D Programmable interrupt controller

040 - 043 System timer

04E - 04F Motherboard resources

050 - 053 System timer

060 - 060 Standard 101/102-Key or Microsoft Natural PS/2 Keyboard with HP QLB

061 - 061 Motherboard resources

062 - 062 Microsoft ACPI-Compliant Embedded Controller

063 - 063 Motherboard resources

064 - 064 Standard 101/102-Key or Microsoft Natural PS/2 Keyboard with HP QLB

065 - 065 Motherboard resources

066 - 066 Microsoft ACPI-Compliant Embedded Controller

067 - 067 Motherboard resources

070 - 070 Motherboard resources

070 - 077 System CMOS/real time clock

080 - 080 Motherboard resources

081 - 091 Direct memory access controller

092 - 092 Motherboard resources

093 - 09F Direct memory access controller

0A0 - 0A1 Programmable interrupt controller

0A4 - 0A5 Programmable interrupt controller

0A8 - 0A9 Programmable interrupt controller

0AC - 0AD Programmable interrupt controller

0B0 - 0B1 Programmable interrupt controller
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I/O address (hex) System function (shipping configuration)

0B2 - 0B3 Motherboard resources

0B4 - 0B5 Programmable interrupt controller

0B8 - 0B9 Programmable interrupt controller

0BC - 0BD Programmable interrupt controller

0C0 - 0DF Direct memory access controller

0F0 - 0F0 Numeric data processor

170 - 177 ATA Channel 1

1F0 - 1F7 ATA Channel 0

200 - 27F Motherboard resources

376 - 376 ATA Channel 1

3B0 - 3BB Mobile Intel 4 Series Express Chipset Family

3C0 - 3DF Mobile Intel 4 Series Express Chipset Family

3F6 - 3F6 ATA Channel 0

400 - 47F Motherboard resources

4D0 - 4D1 Programmable interrupt controller

500 - 57F Motherboard resources

D00 - FFFF PCI bus

1000 - 1003 Motherboard resources

1010 - 101F Motherboard resources

2000 - 20FF Marvell Yukon 88E8072 PCI-E Gigabit Ethernet Controller

2000 - 2FFF Intel ICH9 Family PCI Express Root Port 6 – 294A

3000 - 4FFF Intel ICH9 Family PCI Express Root Port 6 – 2948

5000 - 6FFF Intel ICH9 Family PCI Express Root Port 6 – 2944

7000 - 701F Intel ICH9 Family USB Universal Host Controller – 2936

7020 - 703F Intel ICH9 Family USB Universal Host Controller – 2935

7040 - 705F Intel ICH9 Family USB Universal Host Controller – 2934

7060 - 707F Intel ICH9 Family USB Universal Host Controller – 2939

7080 - 709F Intel ICH9 Family USB Universal Host Controller – 2938

70A0 - 70BF Intel ICH9 Family USB Universal Host Controller – 2937

70C0 - 70CF Standard Dual Channel PCI IDE Controller

70D0 - 70DF Standard Dual Channel PCI IDE Controller

70E0 - 70EF Standard Dual Channel PCI IDE Controller

70F0 - 70FF Standard Dual Channel PCI IDE Controller

7100 - 7107 Standard Dual Channel PCI IDE Controller
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I/O address (hex) System function (shipping configuration)

7108 - 710F Standard Dual Channel PCI IDE Controller

7120 - 7127 Mobile Intel 4 Series Express Chipset Family

7128 - 712B Standard Dual Channel PCI IDE Controller

712C - 712F Standard Dual Channel PCI IDE Controller

EF80 - EF9F Motherboard resources

FE00 - FE0F Motherboard resources

FE80 - FE8F Motherboard resources

FFFF - FFFF Motherboard resources

System I/O address specifications, Windows XP
I/O address (hex) System function (shipping configuration)

000 - 01F Direct memory access controller

000 - CF7 PCI bus

020 - 021 Programmable interrupt controller

024 - 025 Programmable interrupt controller

028 - 029 Programmable interrupt controller

02C - 02D Programmable interrupt controller

02E - 02F Motherboard resources

030 - 031 Programmable interrupt controller

034 - 035 Programmable interrupt controller

038 - 039 Programmable interrupt controller

03C - 03D Programmable interrupt controller

040 - 043 System timer

04E - 04F Motherboard resources

050 - 053 System timer

060 - 060 Standard 101/102-Key or Microsoft Natural PS/2 Keyboard with HP QLB

061 - 061 Motherboard resources

062 - 062 Microsoft ACPI-Compliant Embedded Controller

063 - 063 Motherboard resources

064 - 064 Standard 101/102-Key or Microsoft Natural PS/2 Keyboard with HP QLB

065 - 065 Motherboard resources

066 - 066 Microsoft ACPI-Compliant Embedded Controller

067 - 067 Motherboard resources
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I/O address (hex) System function (shipping configuration)

070 - 070 Motherboard resources

070 - 077 System CMOS/real time clock

080 - 080 Motherboard resources

081 - 091 Direct memory access controller

092 - 092 Motherboard resources

093 - 09F Direct memory access controller

0A0 - 0A1 Programmable interrupt controller

0A4 - 0A5 Programmable interrupt controller

0A8 - 0A9 Programmable interrupt controller

0AC - 0AD Programmable interrupt controller

0B0 - 0B1 Programmable interrupt controller

0B2 - 0B3 Motherboard resources

0B4 - 0B5 Programmable interrupt controller

0B8 - 0B9 Programmable interrupt controller

0BC - 0BD Programmable interrupt controller

0C0 - 0DF Direct memory access controller

0F0 - 0F0 Numeric data processor

200 - 27F Motherboard resources

2E4 - 2E7 ISAPNP Read Data Port

3B0 - 3BB Mobile Intel 4 Series Express Chipset Family

3C0 - 3DF Mobile Intel 4 Series Express Chipset Family

3F6 - 3F6 ATA Channel 0

400 - 47F Motherboard resources

4D0 - 4D1 Programmable interrupt controller

500 - 57F Motherboard resources

A79 - A79 ISAPNP Read Data Port

D00 - FFFF PCI bus

1000 - 1003 Motherboard resources

1010 - 101F Motherboard resources

2000 - 20FF Marvell Yukon 88E8072 PCI-E Gigabit Ethernet Controller

2000 - 2FFF Intel ICH9 Family PCI Express Root Port 6 – 294A

3000 - 4FFF Intel ICH9 Family PCI Express Root Port 6 – 2948

5000 - 6FFF Intel ICH9 Family PCI Express Root Port 6 – 2944

7000 - 701F ICH9M-E/M SATA AHCI Controller
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I/O address (hex) System function (shipping configuration)

7020 - 703F Intel ICH9 Family USB Universal Host Controller – 2936

7040 - 705F Intel ICH9 Family USB Universal Host Controller – 2935

7060 - 707F Intel ICH9 Family USB Universal Host Controller – 2934

7080 - 709F Intel ICH9 Family USB Universal Host Controller – 2939

70A0 - 70BF Intel ICH9 Family USB Universal Host Controller – 2938

70C0 - 70DF Intel ICH9 Family USB Universal Host Controller – 2937

70E0 - 70E7 ICH9M-E/M SATA AHCI Controller

70E8 - 70EF ICH9M-E/M SATA AHCI Controller

70F0 - 70F7 Mobile Intel 4 Series Express Chipset Family

70F8 - 70FB ICH9M-E/M SATA AHCI Controller

70FC - 70FF ICH9M-E/M SATA AHCI Controller

EF80 - EF9F Motherboard resources

FE00 - FE0F Motherboard resources

FE80 - FE8F Motherboard resources

FFFF - FFFF Motherboard resources

System memory map specifications, Windows Vista
Memory address System function

000A0000-000BFFFF Mobile Intel 4 Series Express Chipset Family

000A0000-000BFFFF PCI Bus

80000000-8FFFFFFF Mobile Intel 4 Series Express Chipset Family

80000000-DFFFFFFF PCI Bus

90000000-903FFFFF Mobile Intel 4 Series Express Chipset Family

90400000-904FFFFF Mobile Intel 4 Series Express Chipset Family

90500000-905FFFFF Intel 82801 PCI Bridge – 2448

90600000-90603FFF Marvell Yukon 88E8072 PCI-E Gigabit Ethernet
Controller

90600000-906FFFFF Intel ICH9 Family PCI Express Port 6 – 294A

90700000-946FFFFF Intel ICH9 Family PCI Express Port 5 – 2948

94700000-986FFFFF Intel ICH9 Family PCI Express Port 3 – 2944

98700000-98703FFF Broadcom 802.11b/g WLAN

98700000-987FFFFF Intel ICH9 Family PCI Express Port 2– 2942

98800000-988FFFFF Intel ICH9 Family PCI Express Port 1 – 2940

98900000-98903FFF High Definition Audio Controller
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Memory address System function

98904000-989043FF Intel ICH9 Family USB2 Enhanced Host Controller –
293A

98904400-989047FF Intel ICH9 Family USB2 Enhanced Host Controller –
293C

E0000000-EFFFFFFF Motherboard resources

F0000000-FEDFFFFF High precision event timer

FEC00000-FEC00FFF Motherboard resources

FED00000-FED003FF Motherboard resources

FED10000-FED13FFF Motherboard resources

FED18000-FED18FFF Motherboard resources

FED1C000-FED1FFFF Motherboard resources

FED20000-FED3FFFF Motherboard resources

FED40000-FED44FFF Motherboard resources

FED45000-FED8FFFF Motherboard resources

FEE01000-FFFFFFFF PCI Bus

FF000000-FFFFFFFF Intel 82802 Firmware Hub Device

System memory map specifications, Windows XP
Memory address System function

000A0000-000BFFFF Mobile Intel 4 Series Express Chipset Family

000A0000-000BFFFF PCI Bus

40000000-4FFFFFFF Mobile Intel 4 Series Express Chipset Family

40000000-DFFFFFFF PCI Bus

50000000-503FFFFF Mobile Intel 4 Series Express Chipset Family

50400000-504FFFFF Mobile Intel 4 Series Express Chipset Family

50600000-50603FFF Marvell Yukon 88E8072 PCI-E Gigabit Ethernet
Controller

50600000-506FFFFF Intel ICH9 Family PCI Express Port 6 – 294A

50700000-546FFFFF Intel ICH9 Family PCI Express Port 5 – 2948

54700000-586FFFFF Intel ICH9 Family PCI Express Port 3 – 2944

58700000-58703FFF Broadcom 4322AG 802.11a/b/g/draft-n Wi-Fi
Adapter

58700000-587FFFFF Intel ICH9 Family PCI Express Port 2– 2942

58800000-588FFFFF Intel ICH9 Family PCI Express Port 1 – 2940

58900000-58903FFF Microsoft UAA Bus Driver for High Definition Audio
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Memory address System function

58904000-589047FF Intel ICM9M-E/M SATA AHCI Controller

58904800-58904BFF Intel ICH9 Family USB2 Enhanced Host Controller –
293A

58904C00-58904FFF Intel ICH9 Family USB2 Enhanced Host Controller –
293C

E0000000-EFFFFFFF Motherboard resources

F0000000-FEDFFFFF PCI Bus

FEC00000-FEC00FFF Motherboard resources

FED00000-FED003FF High Precision Event Timer

FED10000-FED13FFF Motherboard resources

FED18000-FED18FFF Motherboard resources

FED19000-FED19FFF Motherboard resources

FED1C000-FED1FFFF Motherboard resources

FED20000-FED3FFFF Motherboard resources

FED40000-FED44FFF Motherboard resources

FED45000-FED8FFFF Motherboard resources

FEE01000-FFFFFFFF PCI Bus

FF000000-FFFFFFFF Intel 82802 Firmware Hub Device
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7 Screw listing

This chapter provides specification and reference information for the screws used in the computer. All
screws listed in this section are available in the Screw Kit, spare part number 535870-001.

Torx T8M2.5×6.0 screw

Color Quantity Length Thread Head diameter

Silver 19 6.0 mm 2.5 mm 5.0 mm

Where used: 19 screws that secure the top cover to computers equipped with 15-in displays

Torx T8M2.5×6.0 screw 139



Torx T8M2.5×4.0 screw

Color Quantity Length Thread Head diameter

Silver 2 4.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the top cover to computers equipped with 15-in displays
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Phillips PM2.0×2.0 screw

Color Quantity Length Thread Head diameter

Black 3 2.0 mm 2.0 mm 5.0 mm

Where used: 3 screws that secure the top cover to the computer

Phillips PM2.0×2.0 screw 141



Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 19 3.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive

Where used: 8 screws that secure the display hinges to the 15-in display assembly
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Where used: 6 screws that secure the display hinges to the 14-in display assembly

Where used: 3 screws that secure the fan to the heat sink

Phillips PM2.0×3.0 screw 143



Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Black 2 3.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the switch cover to computers with 14-in displays
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Phillips PM2.5×6.0 screw

Color Quantity Length Thread Head diameter

Black 15 (15-in models) or 30
(14-in models)

6.0 mm 2.5 mm 5.0 mm

Where used:

(1) Six screws that secure the 15-in display to the computer

(2) One screw that secures the optical drive to the computer

Phillips PM2.5×6.0 screw 145



Where used: 8 screws that secure the display bezel to the display enclosure

Where used: 21 screws that secure the top cover to the base enclosure on computers with 14-in
displays

Phillips PM2.5×11.0 captive screw

Color Quantity Length Thread Head diameter

Black 1 11.0 mm 2.5 mm 5.0 mm

Where used: One captive screw (secured by a C-clip) that secures the hard drive to the computer
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Phillips PM3.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive

Phillips PM3.0×4.0 screw 147



Phillips PM2.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the hard drive to the computer

Where used: 2 screws that secure the top cover to the computer
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Phillips PM2.5×3.0 screw

Color Quantity Length Thread Head diameter

Black 17 (15-in models) or 18
(14-in models)

3.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the WLAN module to the system board

Phillips PM2.5×3.0 screw 149



Where used: 2 screws that secure the WWAN module to the system board

Where used: 2 screws that secure the modem module to the system board

Where used: 2 screws that secure the switch cover to the computer

Where used: 2 screws that secure the keyboard to computers with 15-in displays
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Where used: 3 screws that secure the keyboard to computers with 14-in displays

Where used: 4 screws that secure the speakers to the computer

Where used: One screw that secures the USB connector assembly to the computer

Phillips PM2.5×3.0 screw 151



Where used: 2 screws that secure the SIM to the computer
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Phillips PM2.5×4.5 screw

Color Quantity Length Thread Head diameter

Black 4 (15-in models) or

7 (14-in models)

4.5 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the display assembly to computers with 14-in displays

Where used: 4 screws that secure the display panel to the 15-in display enclosure

Phillips PM2.5×4.5 screw 153



Where used: 2 screws that secure the display bezel to the 14-in display enclosure

Where used: One screw in the right rear that secures the top cover to computers with 14-in displays

154 Chapter 7   Screw listing



Phillips PM2.5×3.0 broadhead screw

Color Quantity Length Thread Head diameter

Black 9 (15-in models) or

5 (14-in models)

3.0 mm 2.5 mm 7.0 mm

Where used: 2 screws that secure the system board to computers with 15-in displays

Where used: 3 screws that secure the system board to computers with 14-in displays

Phillips PM2.5×3.0 broadhead screw 155



Where used: 5 screws that secure the switch cover to computers with 15-in displays

Where used: 2 screws that secure the switch cover and power button board to the computer
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Phillips PM2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 1 7.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the USB connector assembly to the computer

Phillips PM2.5×7.0 screw 157



Phillips PM2.5×9.0 captive screw

Color Quantity Length Thread Head diameter

Silver 7 (discrete) or 5 (UMA) 9.0 mm 2.5 mm 5.0 mm

Where used: 7 screws that secure the heat sink to the system board for computers with discrete memory
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Where used: 5 screws that secure the heat sink to the system board for computers with UMA memory

Phillips PM2.5×9.0 captive screw 159



8 Backup and recovery

Backup and recovery in Windows Vista
Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information 
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on
the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery 
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)” section
in this guide.
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Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the “Using
a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search
for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The f11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
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4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system
DVD to reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows Vista operating system
DVD, go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

Backup and recovery in Windows Vista 163

http://www.hp.com/support


Backup and recovery in Windows XP
Overview

To protect your information, use the Windows® Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information 
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:
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NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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9 Connector pin assignments

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock

External monitor 167



RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter

identifying 20,  32
spare part numbers 45,  46,

47
antenna, disconnecting 70,  77
applications key, Windows 14,

15
audio, product description 4
audio-in (microphone) jack

identifying 16,  27
pin assignments 166

audio-out (headphone) jack
identifying 16,  27
pin assignments 166

B
backing up

Windows Vista 160
Windows XP 164

Backup and Restore Center 160,
161

base enclosure, spare part
number 39,  48

battery
identifying 32,  60
removal 60
spare part number 39,  48,

50,  60
battery bay 19,  30
battery light, identifying 17,  28
battery release latches,

identifying 19,  30
bezel, spare part numbers 49
BIOS administrator

password 113

Blu-ray ROM DVD+/-RW
SuperMulti DL Drive

spare part number 39,  48,
66

specifications 128
Bluetooth cable, illustrated 43
Bluetooth module

removal iii
spare part number 46,  50,  iii

boot options 115,  121
boot order 115,  121
built-in device

Bluetooth device radio 116
embedded WLAN 116
integrated camera 116
LAN/WLAN switching 116
microphone 116
modem 116
Network Interface Controller

(LAN) 116
optical disc drive 116
options 116
Wake on LAN 116
wireless button 116
WWAN device radio 116

buttons
Info Center 13,  24
power 13,  24
QuickLook 13,  24
TouchPad 11,  22
wireless 16

C
Cable Kit

contents 43
spare part number 43,  49,

50
cables, service considerations 54
caps lock light, identifying 12,  23
chipset, product description 2

components
additional hardware 20,  32
bottom 19,  30
display 10,  21
front 16,  27
left-side 18,  29
right-side 17,  28
top 11,  22
wireless antennas 19,  31

computer feet
locations 59
spare part number 59

Computer Setup
accessing 110,  117
Diagnostics menu 114,  120
File menu 112,  119
navigating and selecting 110,

118
restoring factory settings 111,

118
Security menu 113,  120
System Configuration

menu 115,  121
using 110,  118

computer specifications 123
connector, power 17,  28
connectors, service

considerations 54
cord, power 20,  32

D
device configurations 115
Diagnostics menu 114,  120
discs

Driver Recovery 165
Operating System 165

Disk Sanitizer 113
diskette drive

precautions 54
product description 4
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display assembly
removal 78,  iii
spare part numbers 34,  35,

50,  51,  78,  iii
display bezel

removal 80,  92
spare part number 40,  49,

80,  93
Display Cable Kit, spare part

number 41,  49
display cable, spare part

number 49
display component recycling 172
display enclosure

spare part numbers 49
display enclosure, spare part

number 41,  50
Display Hinge Kit, spare part

number 40,  48,  82,  94
display panel

removal 81,  94
spare part numbers 51

display specifications 124,  125
drive light, identifying 16,  27
DriveLock

automatic 113
password 113

Driver Recovery disc 165
drives

boot order 115,  121
optical 17,  28
preventing damage 54

Dual-Core CPU 115
DVD drives

spare part numbers 39,  44,
48,  66

specifications 129
DVD±RW Double-Layer Drive with

LightScribe
precautions 54
removal 48
spare part number 39,  44,

48,  66
specifications 127

E
electrostatic discharge 55
error log 114
esc key, identifying 14,  15,  25,

26

Ethernet, product description 4
Execution Disable 115
ExpressCard slot bezel,

illustrated 42
ExpressCard slot, identifying 18,

29
external media cards, product

description 5
external monitor port

identifying 18,  29
pin assignments 167

F
f11 recovery 162
fan

removal 103
spare part number 36,  47,

100
feet

locations 59
spare part number 59

File menu 112,  119
fn key, identifying 14,  15,  25,

26
function keys, identifying 14,  15,

25,  26

G
graphics, product description 2
grounding equipment and

methods 57

H
hard disk test 114
hard drive

precautions 54
product description 3
removal iii
spare part numbers 39,  44,

48,  50,  51,  iii
specifications 126

hard drive bracket, removal 75
hard drive recovery 162
headphone (audio-out) jack

identifying 16,  27
pin assignments 166

heat sink
removal 100
spare part number 36,  48,

100
hinge, spare part number 82,  94

HP QuickLook 2 115
HP SpareKey enrollment 113

I
I/O address specifications

Windows Vista 132
Windows XP 134

identifying 20
Info Center/QuickLook button,

identifying 13,  24
Info Center/QuickLook light,

identifying 12,  23
internal display switch,

identifying 10,  13,  21,  24
internal microphone,

identifying 10,  21
interrupt specifications

Windows Vista 130
Windows XP 131

J
jacks

audio-in (microphone) 16,  27
audio-out (headphone) 16,

27
RJ-11 (modem) 17,  28
RJ-45 (network) 18,  29

K
keyboard

product description 6
removal iii
spare part number 35,  48,

49,  50,  iii
keypad keys, identifying 14,  15,

25,  26
keys

esc 14,  15,  25,  26
fn 14,  15,  25,  26
function 14,  15,  25,  26
keypad 14,  15,  25,  26
Windows applications 14,  15
Windows logo 14,  15

L
language, changing in Computer

Setup 115
latches, battery release 19,  30
legacy support, USB 110,  115,

117,  121
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lights
battery 17,  28
caps lock 12,  23
drive 16,  27
Info 12
Info Center/QuickLook 23
optical drive 17,  28
power 12,  23
QuickLook 12
QuickLook/Info Center 23
webcam 10,  21
wireless 16,  27

M
mass storage devices, spare part

numbers iii
Media Card Reader,

identifying 16,  27
memory map specifications

Windows Vista 136
Windows XP 137

memory module
product description 3
removal 65
spare part numbers 38,  48,

65
microphone (audio-in) jack

identifying 16,  27
pin assignments 166

model name 1
modem jack, pin

assignments 168
modem module

product description 4
removal 97
spare part number 36,  47,

97
monitor port

external 18,  29
pin assignments 167

N
network jack, pin

assignments 169

O
operating system disc 165
operating system, product

description 6
optical drive

identifying 17,  28

precautions 54
product description 4
removal 66
spare part number 39,  44,

66
specifications 127,  128,  129

optical drive bezel, illustrated 42
optical drive connector

removing 108
spare part number 37,  108
spare part numbers 48

optical drive light, identifying 17,
28

P
packing guidelines 56
palm rest

removal 71
spare part numbers 35,  48,

51,  71
panels, product description 2
passwords 113,  120
pin assignments

166
audio-in jack 166
external monitor port 167
headphone jack 166
microphone jack 166
modem jack 168
monitor port 167
network jack 169
RJ-11 168
RJ-45 jack 169
USB port 169

plastic parts 53
Plastics Kit

contents 42
spare part number 42,  47

pointing devices, product
description 6

port options
ExpressCard slot 116
flash media reader 116
USB port 116

ports
external monitor 18,  29
HDMI 18,  29
product description 5
USB 17,  18,  28,  29

power button board
illustrated 43
removal 88
spare part number 39,  51,

88
power button, identifying 13,  24
power cable, illustrated 43
power connector, identifying 17,

28
power cord

identifying 20,  32
set requirements 170
spare part numbers 45,  46
spare parts numbers 46

power light, identifying 12,  23
power requirements 6
processor

product description 1
removal iii
spare part number 37,  47,

51,  iii,  104
product description

audio 4
chipset 2
diskette drive 4
Ethernet 4
external media cards 5
graphics 2
hard drives 3
keyboard 6
memory module 3
modem module 4
operating system 6
optical drives 4
panels 2
pointing devices 6
ports 5
power requirements 6
processors 1
product name 1
security 6
serviceability 9
wireless 5

product name 1

Q
QuickLook/Info Center button,

identifying 13,  24
QuickLook/Info Center light,

identifying 12,  23
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R
recovery partition 162
release latches, battery 19,  30
removal/replacement

preliminaries 53
procedures 58

restore security defaults 116
restore the factory settings 112
restoring the hard drive 162
RJ-11 (modem) cable,

illustrated 43
RJ-11 (modem) jack

identifying 17,  28
pin assignments 168

RJ-45 (network) cable,
illustrated 43

RJ-45 (network) jack
identifying 18,  29
pin assignments 169

RTC battery
removal 90
spare part number 38,  46,

90
Rubber Kit, spare part

number 39,  47
run-in test 114

S
SATA (Serial Advanced

Technology Attachment) devices
AHCI (Advanced Host Controller

Interface) 115
IDE (Integrated Drive

Electronics) 115
Screw Kit

contents 139
spare part number 45,  48

screw listing 139
scroll zone, TouchPad 11,  22
security cable slot, identifying 18,

29
Security menu

allow reset of HP ProtectTools
security keys 113

always prompt for HP SpareKey
enrollment 113

Automatic DriveLock 113
change password 113
Disk Sanitizer 113
DriveLock 113

HP Sparekey 113
HP Sparekey enrollment 113
password policy 113
set up BIOS administrator

password 113
System IDs 113
user management 113

security, product description 6
service considerations 53
service tag 33,  58
serviceability, product

description 9
set security level 116
setup utility

Diagnostics menu 114,  120
File menu 112,  119
navigating and selecting 110,

118
restoring factory settings 111,

118
Security menu 113,  120
System Configuration

menu 115,  121
SIM

removal 108
spare part number 39,  50,

108
slots

ExpressCard 18,  29
security cable 18,  29

speakers
identifying 13,  24
removal 69
spare part number 36,  50,

69
specifications

Blu-ray ROM DVD+/-RW
SuperMulti DL Drive 128

computer 123
display 124,  125
DVD-ROM Drive 129
DVD±RW Double-Layer Drive

with LightScribe 127
hard drive 126
I/O addresses, Windows

Vista 132
I/O addresses, Windows

XP 134
interrupts, Windows Vista 130
interrupts, Windows XP 131

memory map, Windows
Vista 136

memory map, Windows
XP 137

optical drive 127,  128,  129
system DMA 130

start-up test 114
static-shielding materials 57
stringent security 120
switch cover

removal iii
spare part number 35,  48,

50,  iii
switch, wireless 27
system board

removal iii
spare part number 36,  51,  iii

System Configuration menu 115,
121

system date and time 112
System Diagnostics menu 114
system DMA 130
system fan 115,  121
system IDs 113
system information 112,  119
system memory map 136,  137

T
thermal material,

replacement 101,  102
tools required 53
top cover

removal 84
spare part number 36,  48,

84
TouchPad buttons,

identifying 11,  22
TouchPad cable, illustrated 43
TouchPad scroll zone,

identifying 11,  22
TouchPad, identifying 11,  22
transporting guidelines 56

U
Unified Extensible Firmware

Interface (UEFI) mode 115
USB cable, illustrated 43
USB connector assembly

removal 98
spare part number 98
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USB legacy support 110,  115,
117,  121

USB port
identifying 17,  18,  28,  29
pin assignments 169

V
vents, identifying 18,  29
Virtualization Technology 115

W
webcam

identifying 10,  21
removing 81,  93
spare part number 41,  47,

81,  93
webcam light, identifying 10,  21
Windows applications key,

identifying 14,  15
Windows Backup utility 164,  165
Windows logo key, identifying 14,

15
Windows recovery 161,  165
Windows Vista operating system

DVD 163
wireless antenna,

disconnecting 70,  77
wireless light, identifying 16,  27
wireless switch, identifying 16,

27
wireless, product description 5
WLAN antennas, identifying 20,

31
WLAN module

removal 76
spare part number 37,  46,

47,  76
workstation guidelines 56
WWAN antennas, identifying 19,

31
WWAN module

removal iii
spare part number 39,  46,

50,  iii
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